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1. Úvod 
Restaurování starých fotografií je klíčovou činností pro uchování historických a kulturních 
záznamů. Fotografie jsou nejen uměleckými díly, ale i cennými dokumenty, které zachycují 
okamžiky z minulosti a přenášejí je do současnosti. Historické fotografie města Most, které 
dokumentují jeho proměny a život jeho obyvatel, jsou skvělým příkladem toho, jak důležité je 
zachovat tyto vizuální záznamy pro budoucí generace. 

Město Most, se svou bohatou historií a dramatickými změnami, nabízí nespočet fascinujících 
příběhů zachycených na fotografiích. Tyto snímky nám umožňují nahlédnout do minulosti a 
pochopit sociální, kulturní a ekonomické změny, které město zažilo. Například fotografie z 
období před demolicí starého města v 60. letech 20. století nám poskytují cenné vizuální 
svědectví o architektonickém dědictví, které bylo ztraceno, a o životě lidí v té době. 

Proces restaurování těchto fotografií je nezbytný pro zachování jejich historické hodnoty. 
Staré snímky často trpí různými formami poškození, jako jsou škrábance, prach, ztráta barev 
a rozmazání. K zajištění jejich trvanlivosti a kvality je vhodné použít pokročilé technologie a 
metody, které umožňují obnovu a vylepšení obrazů. 

Tento dokument se zaměřuje na podrobný popis technologií používaných pro vylepšení kvality 
starých snímků. Prozkoumáme dvě hlavní oblasti restaurování: kolorizaci a odstranění 
nepřesností a škrábanců. Kolorizace černobílých fotografií přidává nový rozměr historickým 
snímkům a umožňuje nám lépe pochopit atmosféru a kontext doby, ve které byly pořízeny. 
Odstranění nepřesností a škrábanců je pak klíčové pro obnovu estetické a vizuální kvality 
fotografií, což umožňuje jejich plné ocenění. 

Restaurování fotografií má také významné sociální a kulturní dopady. Uchování historických 
snímků umožňuje komunitám udržovat spojení s jejich minulostí a identitou. Pro město Most, 
které prošlo dramatickými změnami, je restaurování starých fotografií způsobem, jak si 
připomenout a uchovat jeho bohatou historii. Tyto fotografie mohou být použity v muzeích, 
výstavách, publikacích a online archivech, což umožňuje široké veřejnosti přístup k 
historickým záznamům a zvyšuje povědomí o kulturním dědictví města. 

Cílem tohoto dokumentu je poskytnout ucelený přehled o metodách, nástrojích a postupech, 
které jsou k dispozici pro efektivní restaurování starých fotografií. Doufáme, že naše práce 
přispěje k dalšímu výzkumu a vývoji v této oblasti a podpoří úsilí o uchování historických a 
kulturních záznamů pro budoucí generace. Restaurování fotografií je nejen technickým 
úkolem, ale také formou umění, která spojuje minulost s přítomností a umožňuje nám znovu 
prožít okamžiky zachycené na starých snímcích. 
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2. Přehled použité technologie 
Technologie pro restaurování fotografií využívají kombinaci pokročilých algoritmů, umělé 
inteligence (AI) a strojového učení (ML) k vylepšení obrazových dat. Tyto technologie 
umožňují detailní analýzu a zpracování obrazů, čímž zajišťují jejich obnovu a vylepšení. V této 
kapitole krátce prozkoumáme jednotlivé oblasti technologie, které jsou využívány při 
restaurování fotografií. 

2.1 Algoritmy a umělá inteligence 

Pokročilé algoritmy pro restaurování fotografií mohou být pro jednoduchost rozděleny do dvou 
hlavních kategorií: metody využívající umělou inteligenci a strojové učení, a deterministické 
metody, které AI nevyužívají. 

2.1.1 Metody využívající AI a ML 

Umělá inteligence a strojové učení přinášejí do oblasti restaurování fotografií revoluční 
pokroky. Tyto technologie umožňují automatizovat a zlepšit procesy, které byly dříve časově 
náročné a vyžadovaly manuální zásahy. Algoritmy založené na AI a ML jsou schopny se učit 
z obrovského množství obrazových dat a aplikovat naučené vzory a techniky na nové 
fotografie. To nejen zrychluje proces restaurování, ale také výrazně zvyšuje kvalitu výsledků. 
Klíčové technologie v této oblasti zahrnují neurální sítě, generativní adversariální sítě (GAN) 
a konvoluční neurální sítě (CNN). 

Neuronové sítě 

Neuronové sítě (či alternativně neurální sítě) jsou inspirovány biologickými procesy v lidském 
mozku. Jsou trénovány na obrovských souborech dat, aby rozpoznávaly a opravovaly různé 
druhy poškození na fotografiích, jako jsou škrábance, prach a rozmazání. Hluboké neuronové 
sítě (deep neural networks) jsou zvláště účinné díky své schopnosti automaticky extrahovat a 
učit se relevantní rysy z dat bez potřeby explicitního programování těchto rysů. 

● Trénovací data: Neurální sítě vyžadují velké množství trénovacích dat, která zahrnují 
jak poškozené, tak nepoškozené fotografie. Data jsou často anotována, což znamená, 
že jsou označeny specifické oblasti poškození a jejich správné opravy. 

● Architektura sítě: Typická architektura hluboké neurální sítě pro zpracování obrazu 
zahrnuje více vrstev, které zpracovávají data na různé úrovně abstrakce. První vrstvy 
mohou rozpoznávat základní rysy, jako jsou hrany a textury, zatímco hlubší vrstvy 
mohou identifikovat složitější struktury a vzory. 

● Příklad aplikace: Nástroj DeOldify využívá hluboké neurální sítě k automatické 
kolorizaci černobílých fotografií. Tato technologie analyzuje černobílý obraz, 
rozpoznává objekty a scény a aplikuje vhodné barvy na základě tréninku na rozsáhlém 
souboru barevných obrázků. 
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Generativní adversariální sítě (GAN) 

Generativní adversariální sítě představují pokročilý typ neurálních sítí, které se skládají ze 
dvou částí: generátoru a diskriminátoru. Tyto dvě sítě spolu soupeří v procesu, který vede k 
neustálému zlepšování kvality generovaných obrazů. 

● Generátor: Tento model vytváří nové obrazové údaje z náhodného vstupu nebo z 
existujícího obrazu. Generátor se snaží vytvořit realistické obrazy, které jsou k 
nerozeznání od skutečných fotografií. 

● Diskriminátor: Tento model hodnotí obrazy generované generátorem a snaží se 
rozlišit, zda jsou skutečné nebo uměle vytvořené. Poskytuje zpětnou vazbu 
generátoru, což umožňuje neustálé zlepšování kvality. 

● Tréninkový proces: GAN jsou trénovány v iterativním procesu, kde generátor a 
diskriminátor neustále zlepšují své schopnosti. Tento proces vede k vytváření stále 
realističtějších obrazů. 

● Příklad aplikace: GAN mohou být použity k odstranění šumu a vylepšení detailů na 
starých fotografiích. Jeden model generuje vylepšený obraz, zatímco druhý model ho 
hodnotí a poskytuje zpětnou vazbu, což vede k optimalizaci výsledku. 

Konvoluční neurální sítě (CNN) 

Konvoluční neurální sítě jsou zvláště účinné pro zpracování obrazů díky své schopnosti 
rozpoznat a zachovat jemné detaily a struktury při obnově a vylepšení fotografií. CNN 
využívají konvoluční vrstvy, které aplikují filtry na vstupní obraz a extrahují relevantní rysy. 

● Konvoluční vrstvy: Tyto vrstvy aplikují různé filtry na obraz, které jsou schopny 
detekovat specifické rysy, jako jsou hrany, textury a barvy. Filtry jsou trénovány, aby 
optimalizovaly rozpoznávání těchto rysů. 

● Pooling vrstvy: Tyto vrstvy redukují rozměry dat, což snižuje počet parametrů a 
výpočetní náročnost sítě. Pooling vrstvy také pomáhají sítě odolávat menším posunům 
a deformacím v obraze. 

● Plně propojené vrstvy: Tyto vrstvy kombinují extrahované rysy a provádějí konečné 
klasifikace nebo regresní úkoly. V kontextu restaurování fotografií mohou tyto vrstvy 
pomoci určit, které oblasti obrazu vyžadují opravu a jaké techniky použít. 

● Příklad aplikace: CNN mohou být použity pro automatické retušování fotografií, kde 
se analyzují vstupní obrazy a aplikují se techniky pro odstranění škrábanců, prachu a 
dalších vad. Tyto sítě mohou také pomoci při zaostřování obrazu tím, že identifikují 
oblasti, které potřebují zvýšenou ostrost. 

2.1.2 Deterministické metody 

Deterministické metody, které nevyužívají AI, spoléhají na předem definované algoritmy a 
postupy. Tyto metody jsou často rychlejší a méně náročné na výpočetní výkon, což je činí 
vhodnými pro rychlé a efektivní zpracování velkého množství fotografií. Ačkoli mohou být 
méně flexibilní a přizpůsobivé než metody založené na AI, stále poskytují vysokou kvalitu 
výsledků v mnoha aplikacích. Klíčové techniky zahrnují filtry pro odstranění šumu a 
škrábanců, dekonvoluci a histogramové vyrovnání. Především pak není problém je použít i na 
běžných zařízeních, případně vytvořit vlastní proprietární software.  



6 

Filtry pro odstranění šumu a škrábanců 

Odstranění šumu a škrábanců je zásadním krokem při restaurování starých fotografií. Šum 
může být způsoben různými faktory, včetně věku fotografie, kvality tisku a prostředí, ve kterém 
byla fotografie uložena. Škrábance a jiné vady jsou často výsledkem fyzického poškození. K 
odstranění těchto vad se používají různé filtry. 

● Mediánový filtr: Mediánový filtr je účinný při odstraňování šumu typu "sůl a pepř" 
(náhodné bílé a černé body). Funguje tak, že pro každý pixel v obraze určuje medián 
hodnot v jeho okolí a tuto hodnotu pak použije jako novou hodnotu pixelu. Tento proces 
zachovává hrany a detaily lépe než průměrové filtry. 

○ Postup: Algoritmus se pohybuje po obraze a nahrazuje každý pixel mediánem 
hodnot v definovaném okně (např. 3x3 pixely). 

○ Výhody: Efektivní odstranění šumu bez rozmazání hran. 
○ Nevýhody: Může být méně účinný při odstraňování komplexních vad. 

● Gaussian blur: Gaussian blur je běžně používaný k odstranění jemného šumu a ke 
zjemnění obrazu. Tento filtr aplikuje Gaussianovu funkci na hodnoty pixelů v 
definovaném okně, což má za následek rozmazání obrazu. 

○ Postup: Algoritmus aplikuje vážený průměr pixelů v okolí, přičemž váhy jsou 
dány Gaussianovou funkcí. 

○ Výhody: Efektivní při odstraňování jemného šumu a zjemnění obrazu. 
○ Nevýhody: Rozmazává hrany a může způsobit ztrátu detailů. 

● Adaptive Thresholding: Tato technika je užitečná pro odstranění šumu v obrazech s 
nerovnoměrným osvětlením. Místo globálního prahu se pro každou část obrazu určuje 
lokální práh na základě okolních pixelů. 

○ Postup: Algoritmus rozděluje obraz na malé bloky a aplikuje lokální prahovou 
hodnotu pro každý blok. 

○ Výhody: Zlepšuje kontrast a detaily v různých částech obrazu. 
○ Nevýhody: Může zvýraznit šum v homogenních oblastech. 

● Filtry pro odstranění šumu a škrábanců pomocí AI:Pokročilé algoritmy využívající 
umělou inteligenci poskytují nové možnosti pro efektivní odstranění šumu a škrábanců 
z historických fotografií. Tyto metody zahrnují: 

1. Deep Learning Inpainting: využívá hluboké učení k vyplňování chybějících 
nebo poškozených oblastí obrazu na základě kontextu okolních pixelů. 

○ Postup: Poškozené oblasti jsou vybrány a algoritmus AI generuje 
doplněné oblasti, které odpovídají původnímu vzhledu obrazu. 

○ Výhody: AI modely jsou trénovány na rozsáhlých datových sadách a 
mohou generovat realistické opravy i v oblastech s komplexními 
texturami a vzory. 

○ Nevýhody: Vyžaduje výpočetní výkon a kvalitní trénované modely. 
2. Generative Adversarial Networks (GANs): 

○ Postup: Poškozené oblasti jsou vybrány a generátor GAN vytváří 
opravené oblasti, které se integrují s okolními částmi obrazu. 

○ Výhody: Generuje velmi realistické opravy, které se dobře integrují s 
původním obrazem. 

○ Nevýhody: Trénování GANů je náročné na výpočetní výkon a může 
vyžadovat hodně času a dat. Zároveň trénovací množina nemusí být 
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vhodně pro každý problém (např. obsahuje data jen z jiných 
historických období). 

Dekonvoluce 

Dekonvoluce je pokročilá technika používaná k zaostření rozmazaných fotografií. Rozmazání 
může být způsobeno pohybem kamery, špatným zaostřením nebo dlouhou expozicí. 
Dekonvoluční algoritmy inverzně aplikují rozmazávací funkci, čímž obnovují ostrost obrazu. 

● Princip dekonvoluce: Dekonvoluce se snaží odhadnout původní ostrý obraz, který 
byl rozmazán známou nebo odhadnutou rozmazávací funkcí (PSF - Point Spread 
Function). Tato funkce popisuje, jakým způsobem bylo světlo rozptýleno během 
expozice. 

○ Postup: Algoritmus použije inverzní transformaci, aby odstranil efekt PSF z 
obrazu. 

○ Algoritmy: Wienerova dekonvoluce, Richardson-Lucy dekonvoluce. 
○ Výhody: Obnovuje detail a ostrost v rozmazaných fotografiích. 
○ Nevýhody: Vyžaduje přesnou znalost nebo odhad PSF, může zvýšit šum, 

pokud není PSF správně určena. 
● Richardson-Lucy dekonvoluce: Tato iterativní metoda je obzvláště účinná pro 

odstranění pohybového rozmazání a dalších typů rozmazání. Iterativně optimalizuje 
obraz, aby minimalizovala rozdíly mezi rozmazaným obrazem a obrazem po aplikaci 
PSF. 

○ Postup: Algoritmus opakovaně aplikuje dekonvoluční operaci a aktualizuje 
odhad původního obrazu. 

○ Výhody: Vysoká přesnost při odstraňování rozmazání. 
○ Nevýhody: Vyšší výpočetní náročnost, může být citlivá na šum. 

Histogramové vyrovnání 

Histogramové vyrovnání je technika používaná k zlepšení kontrastu fotografií. Tato metoda 
rovnoměrně distribuuje intenzity pixelů v celém rozsahu hodnot, což vede k výraznějšímu a 
detailnějšímu obrazu. 

● Princip histogramového vyrovnání: Tato metoda redistribuuje histogram obrazu tak, 
aby intenzity pixelů byly rovnoměrně rozloženy. Tím se zvýrazní detaily v tmavých a 
světlých oblastech. 

○ Postup: Algoritmus počítá kumulativní distribuční funkci (CDF) histogramu a 
používá ji k transformaci původních intenzit pixelů. 

○ Výhody: Zlepšuje kontrast a odhaluje detaily skryté v tmavých a světlých 
oblastech. 

○ Nevýhody: Může zvýšit šum v homogenních oblastech, není vhodná pro obrazy 
s už dobře rozloženým histogramem. 

● Adaptivní histogramové vyrovnání (AHE): Tato metoda je vylepšením klasického 
histogramového vyrovnání. Rozděluje obraz na malé bloky a provádí histogramové 
vyrovnání pro každý blok zvlášť. 

○ Postup: Obraz je rozdělen na bloky, pro každý blok je proveden klasický 
histogramový vyrovnání a výsledky jsou kombinovány. 
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○ Výhody: Efektivní pro obrazy s nerovnoměrným osvětlením. 
○ Nevýhody: Může zvýraznit šum, zvláště v homogenních oblastech. 

● Kontrastní omezené adaptivní histogramové vyrovnání (CLAHE): CLAHE 
zlepšuje AHE tím, že omezuje zisk kontrastu, aby se zabránilo nadměrnému 
zvýraznění šumu. 

○ Postup: Po rozdělení obrazu na bloky je histogram každého bloku omezen 
(klipován) a redistribuován, aby se minimalizoval šum. 

○ Výhody: Zlepšuje kontrast bez zvýšení šumu. 
○ Nevýhody: Složitější implementace a vyšší výpočetní náročnost. 

Inpainting (Contextual Filling-in) 

Inpainting, neboli kontextové doplňování, je technika používaná k rekonstrukci chybějících 
nebo poškozených částí obrazu tak, aby opravená oblast byla vizuálně konzistentní s okolím. 
Tato metoda je zvláště užitečná při opravách fotografií s výraznými škrábanci, trhlinami nebo 
jiným poškozením. 

● Texturální inpainting: Texturální inpainting se zaměřuje na obnovu textur v 
poškozených oblastech. Používá vzory z okolí poškozené oblasti k vytvoření 
konzistentní textury. 

○ Postup: Algoritmus analyzuje textury v okolí poškozené oblasti a syntetizuje 
novou texturu, která odpovídá kontextu. 

○ Výhody: Vytváří přirozeně vypadající výsledky u texturovaných oblastí. 
○ Nevýhody: Méně účinný u složitých scén s mnoha různými texturami. 

● Strukturální inpainting: Strukturální inpainting se zaměřuje na obnovu struktury a 
hrany v obraze. Tato metoda používá interpolaci a extrapolaci k rekonstrukci 
geometrických tvarů a linií. 

○ Postup: Algoritmus identifikuje hrany a struktury v okolí poškozené oblasti a 
pokračuje v těchto strukturách do poškozené oblasti. 

○ Výhody: Efektivní pro obnovu geometrických tvarů a linií. 
○ Nevýhody: Méně účinný pro obnovu jemných textur. 

● Patch-based inpainting: Tato metoda používá malé bloky (patches) z 
nepoškozených částí obrazu k opravě poškozených oblastí. Bloky jsou vybírány tak, 
aby co nejlépe odpovídaly okolnímu kontextu. 

○ Postup: Algoritmus vybírá a kopíruje malé bloky z okolních oblastí do 
poškozené oblasti. 

○ Výhody: Vytváří přirozeně vypadající opravy v různých kontextech. 
○ Nevýhody: Výpočetně náročný a může být pomalý u velkých oblastí poškození. 

● Examplar-based inpainting: Tento algoritmus je založen na kopírování a přesouvání 
pixelů z nepoškozených oblastí do poškozených oblastí, s důrazem na zachování 
konzistence textur a struktur. 

○ Postup: Algoritmus postupně vyplňuje poškozenou oblast tím, že hledá 
nejvhodnější vzorky v okolí. 

○ Výhody: Vysoká kvalita opravy a zachování konzistence textur a struktur. 
○ Nevýhody: Vyšší výpočetní náročnost. 

V případě této pokročilé technologie je třeba zdůraznit, že výsledný obraz je v klasických 
metodách bez AI stvořen z vzorků okolních oblastí (např. zkopírování zastíněného okna), ale 
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v případě velkých neurálních sítích to tak už být nemusí. V případě velkých sítích, které se učí 
z velkého množství dat jsou syntetizovaná data nová a nemusí odpovídat realitě. Jsou to tedy 
pravděpodobné odhady bez přesné vazby k realitě a konkrétnímu vyfocenému místu. Jde tedy 
o způsob jak velmi dobře a pravděpodobně odhadnout možnou podobu oblastí, o jejíž 
podobě neexistují žádné důkazy. Tyto metody tedy nemohou odhalit co se nacházelo v 
zastíněných oblastech, poskytují k tomu však velmi dobrý odhad.  

2.2 Fotogrammetrie a modelování 

Vylepšené fotografie mají široké uplatnění nejen v oblasti restaurování, ale i v moderních 
technologiích, jako je fotogrammetrie. Fotogrammetrie je technika, která využívá fotografie k 
měření a modelování objektů a prostředí, což umožňuje vytvářet 3D modely domů, měst a 
čtvrtí. Tato kapitola se zaměří na využití vylepšených fotografií ve fotogrammetrii a na 
vhodnost různých metod pro tuto aplikaci. 

2.2.1 Využití ve fotogrammetrii 

Pro fotogrammetrii jsou důležité vysoce kvalitní fotografie s minimem šumu a maximální 
ostrostí. Vylepšené fotografie mohou výrazně zlepšit přesnost a detailnost 3D modelů. Zde 
jsou některé aplikace: 

Rekonstrukce historických budov 

Pomocí vylepšených fotografií lze přesněji rekonstruovat historické budovy a městské oblasti, 
které byly poškozeny nebo zničeny. Fotogrammetrie umožňuje vytvořit detailní 3D modely na 
základě historických snímků, což může být užitečné pro: 

● Restaurování a konzervace: Detaily z vylepšených fotografií mohou být použity k 
přesnému obnovování architektonických prvků a dekorací. 

● Virtuální muzeum: Digitální rekonstrukce historických budov mohou být použity v 
muzeích nebo online platformách, které umožňují návštěvníkům prohlížet a zkoumat 
historické lokace ve virtuálním prostředí. 

Urbanistické studie 

Vylepšené fotografie mohou být použity k vytváření podrobných 3D modelů měst a čtvrtí, což 
je užitečné pro urbanistické plánování a analýzy. Fotogrammetrie umožňuje analyzovat 
prostorové uspořádání, zástavbu a další urbanistické prvky: 

● Plánování infrastruktury: Detailní 3D modely mohou pomoci při plánování nové 
infrastruktury, jako jsou silnice, mosty a budovy. 

● Analýza změn v čase: Porovnání historických a současných modelů umožňuje 
studium urbanistického rozvoje a změn ve struktuře města. 

Virtuální realita (VR) 

Kvalitní 3D modely vytvořené z vylepšených fotografií mohou být použity ve VR aplikacích, 
které umožňují virtuální prohlídky historických míst. To je zvláště užitečné pro: 
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● Vzdělávací účely: Virtuální prohlídky mohou být použity ve školách a univerzitách k 
výuce historie a architektury. 

● Turistický průmysl: Virtuální prohlídky mohou přitáhnout turisty a zvýšit zájem o 
historická místa. 

2.2.2 Vhodnost metod pro fotogrammetrii 

Pro účely fotogrammetrie (FM), jsou některé metody vhodnější než jiné. Kvalita a typ metod 
použité pro restaurování fotografií mohou významně ovlivnit výsledky při tvorbě 3D modelů. 
Zde je detailní rozbor vhodnosti a nevhodnosti jednotlivých metod pro fotogrammetrii. 

Metody založené na AI 

Výhody 

● Vysoce kvalitní výsledky: Metody založené na AI, jako jsou neurální sítě a GAN, 
mohou produkovat velmi realistické a detailní výsledky. Tyto výsledky jsou ideální pro 
přesné modelování ve fotogrammetrii. 

● Automatizace: AI algoritmy mohou automaticky zpracovávat velké množství dat, což 
usnadňuje práci s rozsáhlými fotografickými archivy. 

● Rekonstrukce složitých detailů a textur: AI metody jsou schopny rekonstruovat 
jemné detaily a textury, což je klíčové pro realistické 3D modely. 

Nevýhody 

● Vysoké nároky na výpočetní výkon: AI algoritmy jsou často náročné na výpočetní 
výkon, což může být limitující faktor pro některé aplikace. 

● Potřeba velkých tréninkových datových sad: Pro efektivní trénink AI modelů jsou 
zapotřebí velké množství tréninkových dat, což může být nákladné a časově náročné. 

● Vyšší časová náročnost: Trénink a aplikace AI algoritmů mohou být časově náročné, 
což může zpomalit celý proces restaurování a modelování. 

● Nedeterministické vylepšení: AI metody mohou vnést do vylepšených fotografií 
určitý stupeň náhodnosti, což může zhoršit konzistenci a kvalitu výsledné 
fotogrammetrie. Tento nedeterministický přístup může způsobit, že jednotlivé 
fotografie nebudou přesně sladěné, což ovlivní přesnost 3D modelů. 

Deterministické metody 

Výhody 

● Nižší nároky na výpočetní výkon: Deterministické metody, jako jsou filtry a 
dekonvoluce, mají obecně nižší nároky na výpočetní výkon, což je činí vhodnými pro 
rychlé zpracování velkého množství fotografií. 

● Rychlejší zpracování: Tyto metody jsou často rychlejší, což umožňuje efektivní 
zpracování v časově omezených projektech. 

● Spolehlivé výsledky pro jednoduché úlohy: Deterministické metody poskytují 
spolehlivé výsledky pro základní úlohy, jako je odstranění šumu a zlepšení kontrastu. 

Nevýhody 
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● Méně přesné a detailní výsledky: Ve srovnání s metodami založenými na AI mohou 
být výsledky deterministických metod méně detailní a realistické. 

● Omezené schopnosti při zpracování komplexních scén a textur: Deterministické 
metody mohou mít problémy s rekonstrukcí složitých textur a struktur, což může vést 
k méně přesným 3D modelům. 

Kombinace metod 

Výhody 

● Optimalizace kvality a efektivity: Kombinace deterministických metod a metod 
založených na AI může nabídnout nejlepší z obou světů, poskytující vysoce kvalitní 
výsledky při efektivním využití výpočetního výkonu. 

● Preprocessing a postprocessing: Deterministické metody mohou být použity pro 
předběžné zpracování fotografií, zatímco AI metody mohou být použity pro finální 
vylepšení detailů a textur. 

Nevýhody 

● Složitější workflow: Kombinace různých metod může vést ke složitějšímu workflow, 
který vyžaduje pečlivou koordinaci a integraci různých technologií. 

● Potřeba specializovaných znalostí: Efektivní využití kombinovaných metod může 
vyžadovat hlubší technické znalosti a zkušenosti s různými algoritmy a nástroji. 

● Nedeterministické výsledky: Kombinace metod může vnést určitou míru 
nedeterminismu, zejména pokud se AI metody používají v kritických částech procesu. 
To může vést k nekonzistentním výsledkům a ovlivnit kvalitu fotogrammetrie. 

2.2.3 Realistická data vs. odhady 

● Vytváření nových dat: Metody založené na AI, zejména inpainting a filling-in 
algoritmy, vytvářejí nová data, která vyplňují chybějící nebo poškozené části obrazu. 

● Pravděpodobnost, nikoli jistota: Tato nově vytvořená data nejsou autentická ani 
historicky přesná; představují pouze pravděpodobnou rekonstrukci založenou na 
analýze okolních pixelů a vzorců a starších podobných fotek. 

● Vizuální přesvědčivost vs. historická přesnost: I když tato data mohou být 
vizuálně přesvědčivá a esteticky příjemná, nemusí nutně odpovídat skutečné podobě 
původního objektu nebo scény. 

● Dopad na fotogrammetrii: V důsledku těchto odhadů může dojít k tomu, že 
výsledky fotogrammetrie nebudou plně odpovídat realitě, což může ovlivnit 
věrohodnost a přesnost 3D modelů vytvořených na základě těchto fotografií. 

● Nutnost zohlednění: Při využití těchto metod ve fotogrammetrii je proto nezbytné 
brát v úvahu, že výsledné modely mohou obsahovat prvky, které jsou pouze 
pravděpodobnými odhady, nikoli skutečnými historickými daty. 

2.3 Generativní obsah 

Jednou z klíčových a zároveň velmi kontroverzních technologií v oblasti restaurování a úpravy 
historických fotografií je použití nástrojů pro generativní obsah. Tyto nástroje, které zahrnují 
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technologie jako inpainting, filling-in a generative adversarial networks, umožňují vytváření 
nových obrazových dat v místech, kde originální informace chybí nebo jsou poškozené. Ačkoli 
tyto technologie mohou výrazně zlepšit vzhled poškozených fotografií, zároveň vyvolávají 
zásadní etické a historické otázky. 

Proč je generativní obsah kontroverzní? 

● Vytváření nehistorických dat: Generativní nástroje vytvářejí nové části obrazu na 
základě analýzy okolních pixelů a pravděpodobnostních modelů. Výsledkem jsou 
části obrazu, které nikdy neexistovaly v původní podobě. Tyto nové prvky jsou pouze 
odhadem toho, jak by mohly vypadat chybějící nebo poškozené části, a nejsou 
historicky přesné. Tím se do historického záznamu vnášejí prvky, které mohou 
zkreslit skutečnou podobu zachycených scén. 

● Ztráta autenticity: Použití generativního obsahu může vést ke ztrátě autenticity 
fotografie. Historické fotografie jsou často ceněny pro svou věrnost a schopnost 
zachytit skutečný obraz minulosti. Vytváření nových, neexistujících dat může narušit 
tuto autenticitu, což je obzvláště problematické, pokud jsou tyto fotografie používány 
pro vědecké, historické nebo vzdělávací účely. 

● Nesprávná interpretace minulosti: Generativní algoritmy mohou vytvářet vizuálně 
přesvědčivé, ale nepřesné detaily, které mohou být nesprávně interpretovány jako 
skutečné historické záznamy. To může vést k mylným závěrům o podobě a 
charakteru historických událostí nebo objektů, což má dalekosáhlé důsledky pro 
historickou vědu a veřejné vnímání historie. 

● Etické otázky: Použití generativního obsahu vyvolává otázky týkající se etiky úpravy 
historických materiálů. Mělo by být jasně označeno, kdy a kde byly generativní 
nástroje použity, aby byl zachován rozdíl mezi původním historickým materiálem a 
nově vytvořenými prvky. Transparentnost v tomto ohledu je klíčová, aby nedošlo k 
neúmyslnému klamání badatelů nebo veřejnosti. 

Nepřesná data a jejich dopad 

Generativní obsah vnáší do fotografií prvky, které mohou být technicky dokonalé, ale 
historicky nepřesné. V kontextu restaurování historických fotografií to znamená, že výsledek 
může vypadat lépe, než by byl při použití konzervativnějších metod, ale může také vést k 
neúmyslnému zkreslení historie. Z tohoto důvodu je nezbytné používat generativní 
technologie s rozvahou a důrazem na transparentnost a přesnost, zejména pokud jsou 
výsledné fotografie určeny pro historický výzkum nebo veřejnou prezentaci. 

Pro dobrou představu pro schopnosti této metody je nejvhodnější demonstrovat je na příkladu. 
V následující fotce se nachází velké množství objektů, které zastiňují budovu za nimi.  
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Příklad odstraněných objektů - veškeré objekty za ženou i stromem jsou odhady.  
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I Po odstranění ženy a stromu se nachází na fotce mnoho nežádoucích objektů. 
jejich odstranění může poskytnout mnoho kvalitních, ale velmi odlišných výsledků.  
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I Po odstranění ženy a stromu se nachází na fotce mnoho nežádoucích objektů. 
jejich odstranění může poskytnout mnoho kvalitních, ale velmi odlišných výsledků.  
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Pro využití ve fotogrammetrii je proto vhodné použít fotografie, ve kterých nejsou doplněny 
velké oblasti pomocí AI metod. Zaprvé v různých fotkách stejného objektu mohou být 
doplněna různá data, zadruhé je otázka, jak moc historicky věrné zobrazení je požadováno.  

Je proto vhodné poskytovat několik různých výsledků jak podle použité technologie, tak 
techniky - originální vrstvu, vrstvu s opravenými škrábanci a chybami, kolorovanou vrstvu a 
finálně vrstvu s inpaintovanými daty.  

2.4 Shrnutí 

Následující tabulka shrnuje vhodnost a nevhodnost jednotlivých metod pro fotogrammetrii: 

Metoda Vhodnost 

pro FM 

Výhody Nevýhody 

Neurální sítě 
(AI) 

Vysoká 
Vysoce kvalitní 
výsledky, 
automatizace, 
rekonstrukce 
složitých detailů 

Vysoké nároky na 
výpočetní výkon, potřeba 
velkých datových sad, 
vyšší časová náročnost, 
nedeterministické 
vylepšení 

GAN (AI) Střední 
Realisticky 
vypadající 
vylepšení obrazů, 
neustálé 
zlepšování kvality 

Vysoké nároky na 
výpočetní výkon, potřeba 
velkých datových sad, 
vyšší časová náročnost, 
nedeterministické 
vylepšení 

CNN (AI) Vysoká 
Efektivní 
zpracování obrazů, 
zachování jemných 
detailů a struktur 

Vysoké nároky na 
výpočetní výkon, potřeba 
velkých datových sad, 
nedeterministické 
vylepšení 

Medianový filtr 

(Deterministický) 

Střední 
Nižší nároky na 
výpočetní výkon, 
rychlé zpracování 

Méně účinný při 
odstraňování komplexních 
vad, méně detailní 
výsledky 

Gaussian blur 

(Deterministický) 

Nízká 
Nižší nároky na 
výpočetní výkon, 
efektivní 
odstranění 
jemného šumu 

Rozmazává hrany, ztráta 
detailů 
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Dekonvoluce 

(Deterministický) 

Střední 
Obnovuje detail a 
ostrost, vhodné pro 
zaostření 
rozmazaných 
fotografií 

Potřeba přesné znalosti 
PSF, citlivost na šum 

Histogramové 
vyrovnání 

(Deterministický) 

Střední 
Zlepšuje kontrast, 
odhaluje skryté 
detaily 

Zvýšení šumu v 
homogenních oblastech 

Inpainting 

(Deterministický) 

Vysoká 
Rekonstrukce 
poškozených 
oblastí, zachování 
konzistence textur 
a struktur 

Výpočetně náročné, může 
být pomalé u velkých 
oblastí poškození 

Kombinace 
metod 

Vysoká 
Optimalizace 
kvality a efektivity, 
vyvážený přístup 

Složitější workflow, potřeba 
specializovaných znalostí, 
nedeterministické výsledky 
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3. Restaurování starých fotografií 
Staré fotografie, zejména z historických měst jako Most, často trpí různými poškozeními, jako 
jsou škrábance, prach, skvrny a jiné vady. Tyto defekty mohou výrazně ovlivnit kvalitu a 
vizuální přitažlivost snímků. Restaurování těchto chyb je klíčové pro zachování a revitalizaci 
historických fotografií. Tento proces zahrnuje různé techniky, které kombinují vědecké a 
umělecké přístupy k obnově obrazového materiálu. 

Zde předkládáme celkový obecný postup celé rekonstrukce. Jeho jednotlivé kroky budou 
rozebrány níže v podobě přesných postupů a technik.  

3.1 Obecný postup rekonstrukce 

Krok 1. Digitalizace a Předběžná Analýza 

Obrazový materiál je nejprve třeba kvalitně naskenovat v dostatečném rozlišení a kvalitě.  

Digitalizace 

● Proces restaurování začíná digitalizací fyzických fotografií pomocí vysoce kvalitních 
skenerů. To umožňuje vytvoření digitálních kopií, které lze snadno upravovat. 

● Vysoké rozlišení: Pro zajištění maximální kvality je důležité skenovat fotografie ve 
vysokém rozlišení (minimálně 600 dpi). To umožní detailní práci při následné 
rekonstrukci. 

○ Je doporučeno, aby rozlišení skenované fotografie bylo takové, aby pixely 
obrazu reprezentovalo zrno skenované fotografie.  

POZOR: V případě vysokého rozlišení a dpi na kvalitním skeneru lze očekávat, krom 
zdlouhavého digitalizačního procesu, i velký objem dat kolem 500MB až 1GB na každou 
fotografii.   

Předběžná analýza 

● Po digitalizaci je nezbytné provést detailní analýzu stavu fotografie. To zahrnuje 
identifikaci všech viditelných poškození, jako jsou škrábance, prach, skvrny, vyblednutí 
barev a jiné artefakty. 

● Histogramová analýza: Pomocí histogramů lze analyzovat tonalitu a expozici 
fotografie, což pomáhá při plánování kroků restaurování. 

● Zálohování dat: vždy zálohujte naskenovaná data v originálním rozlišení.   

Krok 2. Kolorizace 

Finálním krokem pro rekonstrukci fotek je jejich kolorizace, a to ať už se jedná o fotografie 
plně černobílé, nebo např. sépiové.   
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Automatizované techniky: 

● Webové nástroje: Existuje několik online nástrojů pro automatickou kolorizaci 
černobílých fotografií, které využívají umělou inteligenci k aplikaci realistických barev 
na staré snímky. Mezi nejpopulárnější patří Colourise.com, Img2Go a DeepAI 
Colorizer. Tyto nástroje jsou uživatelsky přívětivé a umožňují rychlé výsledky. 

● Colourise.com: 
○ Jednoduché použití: Colourise.com je ideální pro rychlou a snadnou 

kolorizaci. Uživatelé mohou jednoduše nahrát fotografii a nechat nástroj 
automaticky přidat barvy. 

○ Omezená velikost vstupu: Tento nástroj má omezení velikosti nahrávaných 
souborů, což může být nevýhoda při práci s vysoce kvalitními skeny. 

● Img2Go: 
○ Kvalita výstupu: Img2Go je známý pro vysokou kvalitu výstupu a poskytuje 

více možností pro přizpůsobení výsledné kolorizace. 
○ Dostupnost: Tento nástroj je zdarma dostupný, což je výhodné pro studenty 

a učitele, kteří chtějí používat kvalitní nástroje bez finančních nákladů. 
● DeepAI Colorizer: 

○ Pokročilá technologie: DeepAI Colorizer využívá pokročilé algoritmy umělé 
inteligence k dosažení přesných a realistických výsledků. Je vhodný pro 
detailní a precizní kolorizaci. 

○ Snadné použití: Tento nástroj je uživatelsky přívětivý a poskytuje rychlé 
výsledky. 

● Deep-Exemplar-based-Video-Colorization 
○ Open-source technologie využívající naučenou síť pro obarvení videa (ale je 

možné kolorovat i fotky v menším rozlišení). Pro dobrou funkci je třeba mít 
referenční barevný obrázek.  

○ Použití na příkazovou řádku: Tento nástroj vyžaduje použití linuxového 
terminálu a vlastního výkonného hardwaru s grafickou kartou NVidia. 

○ Cena: Framework je poskytován zcela zdarma. 
○ Link: https://github.com/zhangmozhe/Deep-Exemplar-based-Video-

Colorization  

Automatická, asistovaná, či ruční kolorizace: 

● Adobe Photoshop: Pro detailní a přizpůsobenou kolorizaci je Adobe Photoshop 
jedním z nejlepších nástrojů. Umožňuje ruční přidávání barev s vysokou úrovní 
kontroly nad výsledným vzhledem. 

○ Neurální sítě a AI: Moderní metody využívají umělou inteligenci a hluboké 
učení k automatické detekci a opravě poškození. Tyto algoritmy jsou trénovány 
na rozsáhlých datových sadách a jsou schopny odhadnout barevnou tonalitu 
na základě natrénovaných dat.  

○ Proces může být zcela automatický, ale i plně manuální, stejně jako 
automatický s drobnou manuální korekcí.    

 

 

https://github.com/zhangmozhe/Deep-Exemplar-based-Video-Colorization
https://github.com/zhangmozhe/Deep-Exemplar-based-Video-Colorization
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Krok 3. Odstraňování prachu a škrábanců 

Prvním krokem pro rekonstrukci fotografií je analýza stavu fotografie a doplnění chybějících 
dat ať už manuálními, nebo automatickými technikami.  

Manuální retušování: 

● Klonovací razítko (Clone Stamp Tool): Tento nástroj se používá k ručnímu 
odstranění škrábanců a prachu tím, že klonuje části obrazu z jedné oblasti a aplikuje 
je na poškozenou oblast. 

● Náplastový nástroj (Healing Brush Tool): Tento nástroj kombinuje texturu a barvu z 
vybrané oblasti a aplikuje je na poškozenou oblast, což umožňuje přirozenější opravu. 

● Inpainting algoritmy: Pokročilé algoritmy, jako je "Content-Aware Fill", využívají 
kontextuální informace k rekonstrukci chybějících částí. Tyto algoritmy analyzují okolní 
oblasti a inteligentně doplňují poškozené části obrazu.    

Automatizované techniky: 

● Filtrování: Filtry, jako je "Dust & Scratches" ve Photoshopu, mohou automaticky 
detekovat a odstraňovat malé defekty na fotografiích. Tento proces zahrnuje nastavení 
prahové hodnoty a poloměru, aby se odstranily defekty bez ovlivnění detailů. 

● Neurální sítě a AI: Moderní metody využívají umělou inteligenci a hluboké učení k 
automatické detekci a opravě poškození. Tyto algoritmy jsou trénovány na rozsáhlých 
datových sadách a jsou schopny rozpoznat a rekonstruovat složité vzory a textury. 

Krok 4. Korekce barev a kontrastu (volitelné) 

V případě manuálního doplňování je vhodné provést barevnou korekci a vyvážení obrazu. V 
případě automatické rekonstrukce je tento krok obvykle plně integrován do retušovacího 
procesu.  

Histogramové úpravy: 

● Úrovně (Levels): Tento nástroj umožňuje úpravu tonalit a kontrastu obrazu pomocí 
histogramu. Korekcí úrovní lze odstranit vyblednutí a zlepšit celkový vzhled fotografie. 

● Křivky (Curves): Křivky poskytují detailnější kontrolu nad tonalitou a kontrastem. 
Můžete upravovat jednotlivé kanály (RGB) pro jemné doladění barev a expozice. 

Vyvážení barev: 

● Color Balance: Tento nástroj umožňuje úpravu barevných odstínů na různých 
úrovních (stíny, středy, světlé oblasti), což pomáhá při obnově původních barev. 

Krok 5: Uložení a Export 

● Uložení: 
○ Uložte práci ve formátu PSD (v případě photoshopu), abyste zachovali všechny 

vrstvy. 
○ Exportujte hotový obraz do formátu JPEG (ztrátová komprese), TIFF, či PNG.  
○ Nepřepisujte původní data!  
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3.2 Rozhodovací strom  

Restaurování a kolorizace historických fotografií může být složitý proces, který vyžaduje 
správný přístup a nástroje. Abychom pomohli najít ideální techniku pro různé potřeby různých 
institucí, vytvořili jsme rozhodovací strom, který zohledňuje různé schopnosti, dostupné 
nástroje, preference, či možnost finanční investice do postupu. Tento rozhodovací strom je 
navržen tak, aby poskytl jasné a jednoduché pokyny pro výběr nejvhodnější metody 
restaurování a kolorizace starých fotografií. 

3.2.1 Úvod k Rozhodovacímu stromu 

Rozhodovací strom je nástroj, který čtenářům pomůže rychle a efektivně určit nejlepší přístup 
k restaurování fotografií na základě několika klíčových faktorů: 

1. Dostupnost nástrojů: 
○ Free nástroje: Dostupné bezplatné nástroje pro restaurování a kolorizaci. Jsou 

vhodné pro první kroky, či ozkoušení si nástrojů primárně pro kolorizaci.  
○ Placené nástroje: Komerční software, který může nabídnout mnohem 

pokročilejší funkce a vyšší kvalitu. 
2. Specifické potřeby projektu: 

○ Kolorizace: Potřeba automatické nebo manuální kolorizace. 
○ Odstraňování škrábanců a chyb: Potřeba odstranění prachu, škrábanců a 

jiných vad. 
3. Zdroj nástroje  

○ Webový nástroj: není potřeba nic instalovat, nástroj lze ovládat přes stránku 
dostupnou na internetu. Je vyžadováno kontinuální připojení a veškerý 
výpočetní výkon je prováděn v cloudu, mimo uživatelský počítač.  

○ Instalovatelný software: Nástroj, který je třeba nainstalovat. Výpočet pak 
probíhá v daném počítači, záleží tedy na jeho výkonu.  

○ Cloudový nástroj: Nástroj, který je třeba nainstalovat, nicméně samotný 
výpočet neprobíhá v daném počítači, nezáleží tedy na jeho výkonu.  
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3.2.2 Popis Rozhodovacího Stromu 

Diagram rozhodovacího stromu je strukturován tak, aby uživatelům poskytl přehledný postup 
při výběru techniky a nástrojů na základě jejich specifických potřeb a schopností. Poskytuje 
odpověď na základní otázky a nabízí ideální nástroje a postupy.  

Fotografie k rekonstrukci 

Prvním krokem je identifikace fotografie, která vyžaduje rekonstrukci. Odtud se uživatelé 
rozdělí na základě toho, zda chtějí použít placené, nebo neplacené nástroje.  

Placené nástroje  

Existuje mnoho nástrojů, které jsou placené a slouží k retuší, či kolorizaci. Pro komplexní 
použití je ideálním nástrojem Photoshop. Pokud je pro projekt potřeba jen kolorizace, existují 
kvalitní webové nástroje, které tuto službu poskytují velmi levně a jednoduše. 

Neplacené nástroje  

I v případě neplacených nástrojů není výběr malý. Pokud je potřeba pouze kolorizace, lze 
využít buď nástroje webové, nebo volně šířené balíčky primárně pro operační systém Linux. 
V případně retuše lze doporučit buď software jako je GIMP, který je volnou alternativou 
Photoshopu (ovšem bez neurálních filtrů), či opět volně šířené balíčky pro operační systém 
Linux. Prvé lze použít pro manuální práci, druhé jsou ideální pro automatickou a dávkovou 
práci.     

● Free nástroje: Pokud se rozhodnou pro bezplatné nástroje, je další otázkou, zda 
postačí automatická kolorizace. 

○ Postačí kolorizace: Použijí webové nástroje, jako jsou Img2Go nebo 
Colourise.com. 
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○ Nejprve proveďte kolorizaci pomocí free nástroje: Poté lze použít bezplatný 
software pro odstranění škrábanců, například GIMP. 

● Placené nástroje: Z komerčních nástrojů lze doporučit mnoho nástrojů: 
○ Placený software jako Silverfast pro automatickou kolorizaci a restaurování s 

AI, či k automatickému i ručnímu odstraňování škrábanců a kolorizaci pomocí 
pokročilých nástrojů Adobe Photoshop.  

3.2.3 Závěr 

Rozhodovací strom je navržen tak, aby čtenářům poskytl jasné a strukturované pokyny pro 
výběr správných technik a nástrojů pro restaurování a kolorizaci starých fotografií. Ať už mají 
uživatelé základní nebo pokročilé dovednosti, možnost koupit placený nástroj, či jen nástroj 
poskytovaná zdarma, tento rozhodovací strom jim pomůže najít nejvhodnější přístup k jejich 
specifickým potřebám a cílům. 

3.3 Retušování vs. Kolorizace 

Při restaurování starých fotografií se často klade otázka, zda je vhodnější nejdříve retušovat 
(odstraňovat škrábance, prach a jiné chyby) a pak kolorovat, nebo naopak. Oba postupy mají 
své výhody a nevýhody, pro staré fotky doporučujeme následující pořadí: 

Doporučený postup: nejprve kolorizace, poté retušování 

Proč nejprve kolorovat? 

● Identifikace detailů a struktur: Kolorizace může pomoci lépe identifikovat různé 
detaily a struktury na fotografii, které by mohly být v černobílém formátu snadno 
přehlédnuty. Barva poskytuje dodatečný kontext, který může usnadnit retušování 
složitých textur a detailů. 

● Vylepšení vnímání obrazu: Barva zlepšuje celkové vnímání obrazu a usnadňuje 
rozhodování o tom, které oblasti vyžadují další úpravy. Po kolorizaci může být snazší 
určit, kde je třeba provést jemnější nebo agresivnější retuše, protože barevné rozdíly 
a nedokonalosti jsou lépe viditelné. 

● Zamezení nechtěných artefaktů: Při retušování po kolorizaci lze lépe sladit nově 
vytvořené barvy s texturou a detaily obrazu, čímž se minimalizuje riziko vzniku 
nechtěných artefaktů. Tento přístup umožňuje zajistit, že barvy a textury budou 
působit přirozeně a harmonicky. 

● Přizpůsobení barevné palety: Kolorizace jako první krok umožňuje následné jemné 
doladění barevné palety celého obrazu. Po kolorizaci je snazší sjednotit barvy 
různých částí fotografie a odstranit jakékoli nesrovnalosti, které by mohly vzniknout 
během retuše. 

● Šíření chyby: Při retuší černobíle fotografie je možné degradovat zdrojový materiál 
způsobem, které není poznatelný v černobílé verzi, ale bude vidět až po kolorizaci.   
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Výhody retušování po kolorizaci: 

● Konzistentní výsledky: Retušování po kolorizaci umožňuje provádět úpravy na 
finálním barevném obrazu, což zajišťuje, že výsledky budou konzistentní a esteticky 
příjemné. 

● Jednodušší identifikace vad: Barva může zvýraznit vady a nedokonalosti, které 
jsou v černobílém obraze méně zřetelné. Díky tomu může být retušování přesnější a 
efektivnější. 

● Přirozenější vzhled: Upravování barev a textur současně zajišťuje, že výsledný 
obraz bude působit přirozeněji a bude lépe odpovídat reálným podmínkám. 

Tento přístup může být zvláště výhodný při práci s fotografiemi, které mají složité textury nebo 
obsahují jemné detaily. Postup, kdy se nejprve aplikuje kolorizace a následně retuš, umožňuje 
dosáhnout přirozenějších a konzistentnějších výsledků. 

Ve velmi specifických případech (velmi poškození fotky) může být vhodné postupovat nejdříve 
automatické rekonstrukcí, následně kolorizací fotky a posléze zvolit znovu automatickou, či 
manuální rekonstrukci.  
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4. Retušování digitalizovaných starých fotografií 

4.1 Postup A1: Plně automatické rekonstrukce v Photoshopu 

Adobe Photoshop nabízí pokročilé nástroje pro rekonstrukci a kolorizaci starých fotografií, 
včetně použití neurálních filtrů. Tyto filtry využívají technologie umělé inteligence k 
automatickému vylepšení a obnově obrazového materiálu. Níže je podrobný návod, jak využít 
neurální filtry ve Photoshopu pro automatickou rekonstrukci fotografií. 

Návod je psán tak, aby i laik byl schopen provést základní vylepšení starých fotek, které nejsou 
kriticky poškozené.  

4.1.1 Postup 

Krok 1: Otevření fotografie ve Photoshopu 

1. Spusťte Adobe Photoshop: 
○ Otevřete aplikaci Adobe Photoshop na vašem počítači. 

2. Otevření fotografie: 
○ Přejděte na File > Open (Soubor > Otevřít) a vyberte fotografii, kterou chcete 

rekonstruovat. 

Krok 2: Přístup k Neurálním Filtrům 

1. Otevření panelu Neurálních Filtrů: 
○ Přejděte na Filter > Neural Filters (Fittry > Neural Filters). 

 

2. Výběr filtru pro rekonstrukci fotografie: 
○ V panelu Neurálních Filtrů najděte sekci „Obnovení“ (Restoration). 
○ Aktivujte filtr „Restaurování fotografií“ (Photo Restoration) přepnutím přepínače 

do polohy „On“. 
i. Po přepnutí do polohy „On“ začne okamžitě prvotní výpočet. Ujistěte 

se, že máte veškerou jinou práci uloženou.  
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Krok 3: Nastavení parametrů filtru 

1. Vylepšení fotografie: 
○ Posuňte posuvník „Vylepšení fotografie“ (Photo Enhancement) nejdříve na 

nulu.  
2. Redukce poškrábání: 

○ Posuňte posuvník „Redukce poškrábání“ (Scratch Reduction) pro odstranění 
škrábanců. Začněte s hodnotou 0 a postupně ji zvyšujte, dokud nedosáhnete 
požadovaného výsledku.  

○ I pro velmi poškozené fotky postačuje poměrně malá hodnota (5-15), začnete 
s nízkými hodnotami.  

○ Proces muže v závislosti na hardwaru počítače, zvolené hodnotě a především 
velikosti vstupních dat zabrat nemalý čas - od 5 minut do hodiny.  

 

3. Vylepšení fotografie: 
○ Posuňte posuvník „Vylepšení fotografie“ (Photo Enhancement) pro nastavení 

úrovně vylepšení fotografie. Doporučená hodnota je kolem 50, ale můžete ji 
upravit podle potřeby (viz příklad dole). 

○ Vylepšení fotografie upravit kontrast fotky a vyvážení její histogram. Staré fotky 
jsou obvykle velmi vybledlé, postup tedy fotku obvykle ztmaví a vytvoří 
kontrastnější, živější nevybledlou fotografii.   
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Krok 4: Aplikace a úpravy filtru 

1. Aplikace filtru: 
○ Po nastavení všech parametrů klikněte na tlačítko „OK“ nebo „Apply“ pro 

aplikaci filtru na fotografii. 
2. Kontrola výsledků: 

○ Zkontrolujte výsledek aplikace filtru. Pokud nejste spokojeni, můžete se vrátit 
zpět a upravit nastavení filtru nebo zkusit další ruční úpravy. 

○ Pokud nejste spokojeni s výsledkem, zvolte částečně manuální postup.  

Krok 5: Uložení a export 

1. Uložení práce: 
○ Uložte soubor ve formátu PSD, abyste zachovali všechny vrstvy a možnost 

budoucích úprav (File > Save As). 
2. Export hotové fotografie: 

○ Exportujte finální hotový obraz do formátu JPEG nebo PNG pro sdílení nebo 
archivaci (File > Export > Export As). 

4.1.2 Shrnutí 

Použití neurálních filtrů ve Photoshopu pro automatickou rekonstrukci fotografií je efektivní a 
extrémně jednoduchý způsob, jak rychle a jednoduše obnovit staré a poškozené fotografie. 
Tento postup využívá pokročilou technologii umělé inteligence k vylepšení kvality obrazu a 
odstranění vad, což umožňuje dosažení profesionálních výsledků s minimálním úsilím. 

4.1.3 Příklady výsledků automatické retuše  

 

Vlevo původní (uměle) poškozená fotografie, vpravo automaticky rekonstruované fotografie. 
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Nastavení parametru “vylepšení fotografie” na hodnotu 0 (vlevo), 50 (uprostřed), 
100 (vpravo). 
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4.2 Postup A2: Automatické rekonstrukce v Photoshopu s 
manuální korekcí 

Adobe Photoshop nabízí pokročilé nástroje pro automatickou rekonstrukci a kolorizaci starých 
fotografií pomocí neurálních filtrů. Pro dosažení co nejlepších výsledků je často vhodné 
kombinovat automatickou rekonstrukci s manuálními korekcemi. Tento návod podrobně 
popisuje, jak použít neurální filtry ve Photoshopu pro automatickou rekonstrukci a jak následně 
provést manuální korekce pro optimalizaci výsledků. 

4.2.1 Definice typů chyb 

Před samotným postupem je vhodné definovat různé typy chyb, které lze poloautomatickou 
metodou odstranit. Níže je detailní rozbor čtyř klíčových parametrů: Redukce šumu, Redukce 
barevného šumu, Redukce artefaktů půltónu a Redukce artefaktů JPEG. 

1. Redukce šumu (Noise Reduction) 

Co to je: 

● Redukce šumu je proces odstraňování nežádoucího vizuálního šumu, který se často 
vyskytuje v digitálních fotografiích, zejména v podmínkách s nízkým osvětlením 
nebo při vysokých hodnotách ISO. 

Co dělá: 

● Tento parametr analyzuje obraz a identifikuje oblasti s vysokým šumem. Poté aplikuje 
algoritmy pro hladké odstranění šumu, aniž by došlo k významné ztrátě detailů. 

● Redukce šumu je užitečná pro odstranění zrnitosti a jemných rušivých bodů, což vede 
k čistšímu a profesionálnějšímu vzhledu fotografií. 

Nastavení: 

● Uživatelé mohou upravit posuvník pro zvýšení nebo snížení úrovně redukce šumu. 
Vyšší hodnoty znamenají větší redukci šumu, ale mohou také vést k mírnému 
rozostření detailů. 

2. Redukce barevného šumu (Color Noise Reduction) 

Co to je: 

● Barevný šum se projevuje jako náhodné barevné skvrny na obrázku, často viditelné 
ve stínech nebo tmavých oblastech fotografie. Tento šum je obvykle způsoben 
nedostatečným osvětlením nebo vysokým ISO nastavením. 

Co dělá: 

● Redukce barevného šumu identifikuje a odstraňuje tyto barevné skvrny, čímž zlepšuje 
celkovou kvalitu a uniformitu barev na fotografii. 
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● Tento parametr je klíčový pro dosažení přirozenějšího vzhledu bez rušivých barevných 
anomálií. 

Nastavení: 

● Posuvník umožňuje nastavit intenzitu redukce barevného šumu. Doporučuje se 
postupovat opatrně, aby nedošlo k odstranění barevných detailů, které jsou důležité 
pro autenticitu obrazu. 

3. Redukce artefaktů půltónu (Halftone Artifacts Reduction) 

Co to je: 

● Artefakty půltónu jsou běžné u fotografií, které byly skenovány z tištěných 
materiálů, jako jsou noviny nebo časopisy. Tyto artefakty se projevují jako 
pravidelné vzory nebo tečky, které jsou viditelné na skenovaném obrázku. 

Co dělá: 

● Redukce artefaktů půltónu analyzuje obraz a identifikuje tyto vzory. Poté je odstraní, 
aby se obnovil hladký a jednolitý vzhled fotografií. 

● Tento parametr je obzvláště užitečný pro skenované dokumenty a historické fotografie 
z tištěných zdrojů. 

Nastavení: 

● Uživatelé mohou upravit úroveň redukce podle potřeby, aby odstranili půltónové 
artefakty bez ztráty detailů v obraze. 

4. Redukce artefaktů JPEG (JPEG Artifacts Reduction) 

Co to je: 

● Artefakty JPEG vznikají při kompresi obrazu do formátu JPEG, což je ztrátový 
formát. Tyto artefakty se obvykle projevují jako bloky nebo kruhy, které mohou 
degradovat kvalitu obrazu. 

Co dělá: 

● Redukce artefaktů JPEG identifikuje a odstraňuje tyto kompresní artefakty, čímž 
zlepšuje čistotu a kvalitu fotografie. 

● Tento parametr je obzvláště důležitý pro fotografie, které byly uloženy v nízké kvalitě 
nebo opakovaně komprimovány. 

Nastavení: 

● Posuvník umožňuje nastavit intenzitu redukce artefaktů JPEG. Vyšší hodnoty mohou 
efektivněji odstranit artefakty, ale je důležité sledovat, aby nedošlo k nadměrnému 
vyhlazení detailů. 



31 

 

Jak tyto parametry používat v praxi 

Kombinace těchto parametrů umožňuje komplexní rekonstrukci a vylepšení starých fotografií. 
Zde je doporučený postup, jak je použít efektivně: 

1. Začněte s Redukcí šumu a Barevného šumu: 
○ Nejprve upravte parametry pro redukci šumu a barevného šumu, abyste 

odstranili základní šum a skvrny. 
○ Nastavte hodnoty tak, aby byl šum efektivně redukován, aniž by se ztratily 

důležité detaily. 
2. Pokračujte s Redukcí artefaktů půltónů: 

○ Pokud vaše fotografie obsahuje půltónové artefakty, upravte tento parametr, 
abyste obnovili hladký vzhled fotografie. 

○ Sledujte, aby nedošlo k odstranění jemných textur, které jsou důležité pro 
autenticitu obrazu. 

3. Dokončete s Redukcí artefaktů JPEG: 
○ Pokud jsou na fotografii viditelné kompresní artefakty JPEG, použijte tento 

parametr pro jejich odstranění. 
○ Nastavte hodnotu tak, aby artefakty zmizely, ale detaily zůstaly ostré. 

4.2.2 Postup 

Krok 1: Otevření fotografie ve Photoshopu 

1. Spusťte Adobe Photoshop: 
○ Otevřete aplikaci Adobe Photoshop na vašem počítači. 

2. Otevření fotografie: 
○ Přejděte na File > Open a vyberte fotografii, kterou chcete rekonstruovat. 

Krok 2: Přístup k Neurálním Filtrům 

1. Otevření panelu Neurálních Filtrů: 
○ Přejděte na Filter > Neural Filters. 

2. Výběr filtru pro rekonstrukci fotografie: 
○ V panelu Neurálních Filtrů najděte sekci „Obnovení“ (Restoration). 
○ Aktivujte filtr „Restaurování fotografií“ (Photo Restoration) přepnutím přepínače 

do polohy „On“. 

Krok 3: Nastavení parametrů filtru 

1. Vylepšení fotografie: 
○ Posuňte posuvník „Vylepšení fotografie“ (Photo Enhancement) nejdříve na 

nulu.  
2. Redukce poškrábání: 

○ Posuňte posuvník „Redukce poškrábání“ (Scratch Reduction) pro odstranění 
škrábanců. Začněte s hodnotou 0 a postupně ji zvyšujte, dokud nedosáhnete 
požadovaného výsledku.  
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○ I pro velmi poškozené fotky postačuje poměrně malá hodnota (5-15), začnete 
s nízkými hodnotami.  

○ Proces muže v závislosti na hardwaru počítače, zvolené hodnotě, a především 
velikosti vstupních dat zabrat nemalý čas - od 5 minut do hodiny.  

3. Vylepšení fotografie: 
○ Posuňte posuvník „Vylepšení fotografie“ (Photo Enhancement) pro nastavení 

úrovně vylepšení fotografie. Doporučená hodnota je kolem 50, ale můžete ji 
upravit podle potřeby (viz příklad dole). 

○ Vylepšení fotografie upravit kontrast fotky a vyvážení její histogram. Staré fotky 
jsou obvykle velmi vybledlé, postup tedy fotku obvykle ztmaví a vytvoří 
kontrastnější, živější nevybledlou fotografii.  

4. Redukce šumu: 
○ Posuňte posuvník „Redukce šumu“ (Noise Reduction) pro snížení šumu v 

obraze. Nastavte hodnotu podle potřeby, aby se odstranil šum bez ztráty 
detailů. 

i. Tento parametr je podstatná především o digitálních fotoaparátu nebo 
u velmi nekvalitních fotografií.  

ii. Kombinace Redukce šumu a Odstranění škrábanců je časově i 
výkonnostně velmi náročná operace.  

1. Ujistěte se, že máte veškerou práci uloženou 
2. Kombinace zatěžuje grafický procesor, nepř. přehrávání hudby 

může být v této době problematické. Doporučujeme pozastavit 
jiné programy využívající grafický procesor.   

5. Redukce barevného šumu: 
○ Posuňte posuvník „Redukce barevného šumu“ (Color Noise Reduction) pro 

odstranění barevného šumu. Tento parametr je užitečný zejména pro 
odstranění nežádoucích barevných skvrn. 

○ Tyto skvrny mohou vznikat jak velkým fyzickým poškozením fotografií, nebo 
například focením proti zdroji světla.  

○ Obvykle postačují nízké hodnoty kolem 10-20, postupně zvyšuje hodnotu 
dokud nedosáhnete požadovaného výsledku.  

6. Redukce artefaktů půltónu: 
○ Posuňte posuvník „Redukce artefaktů půltónu“ (Halftone Artifacts Reduction) 

pro odstranění artefaktů vzniklých půltónovým tiskem. 
○ Pro většinu fotek je ideální hodnota 50-70   

7. Redukce artefaktů JPEG: 
○ Pokud pracujete s fotografií ve formátu JPEG, jsou li JPEG chyby okem 

viditelné, nastavte parametr na hodnotu 80-95.  
i. Zkuste použít lupu, artefakty jsou viditelné především u kontrastních 

hran. Může dojít k i nepatrnému barevnému posuvu (viz příklad), v 
takovém případě zvolte hodnotu 95-100. 
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Ukázka redukce JPEG komprese, patrné především i kontrastních hran.  

 

Krok 4: Aplikace a úpravy filtru 

1. Aplikace filtru: 
○ Po nastavení všech parametrů klikněte na tlačítko „OK“ nebo „Apply“ pro 

aplikaci filtru na fotografii. 
2. Kontrola výsledků: 

○ Zkontrolujte výsledek aplikace filtru. Pokud nejste spokojeni, můžete se vrátit 
zpět a upravit nastavení filtru nebo zkusit další ruční úpravy. 

Krok 5: Manuální Korekce 

1. Další retuše: 
○ Po aplikaci neurálního filtru můžete provést další ruční úpravy pomocí nástrojů 

jako Clone Stamp Tool, Healing Brush Tool, nebo Patch Tool pro odstranění 
zbylých vad a jemné doladění detailů. 

2. Clone Stamp Tool: 
○ Vyberte Clone Stamp Tool (S). 
○ Držte Alt a klikněte na čistou oblast poblíž vady pro nastavení zdroje klonování. 
○ Malujte přes vady, abyste je odstranili. 

3. Healing Brush Tool: 
○ Vyberte Healing Brush Tool (J). 
○ Klikněte na čistou oblast pro nastavení zdroje a malujte přes poškozenou 

oblast pro přirozenější opravu. 
4. Patch Tool: 

○ Vyberte Patch Tool (J). 
○ Vyberte poškozenou oblast a přetáhněte výběr na čistou část obrazu pro 

rekonstrukci. 
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Krok 6: Uložení Výsledku 

1. Uložení souboru ve formátu PSD: 
○ Doporučujeme uložit upravený soubor ve formátu PSD, abyste mohli případně 

provést další úpravy v budoucnu. Jděte na File > Save As (Soubor > Uložit 
jako…)  a vyberte Photoshop (*.PSD, *.PDD). 

2. Export hotové fotografie: 
○ Pro sdílení nebo tisk můžete exportovat finální kolorizovaný obrázek do 

běžného formátu, jako je JPEG nebo PNG. 
○ Jděte na File > Export > Export As. 
○ Vyberte požadovaný formát (např. JPEG nebo PNG) a nastavte kvalitu a 

rozlišení podle potřeby. 
○ Klikněte na Export a vyberte umístění pro uložení souboru. 

i. Pro rychlejší export lze zvolit možnost Fast export as PNG (Rychle 
exportovat jako PNG) z kontextového menu 

Krok 7: Práce s Vrstvami (volitelné) 

 

1. Panel Vrstvy: 
○ Ujistěte se, že máte otevřený panel Vrstvy (Layers). Pokud není viditelný, 

můžete jej otevřít přes Window > Layers nebo stisknutím klávesy F7. 
○ Pokud jste filtr nastavili správně, jsou vidět dvě vrstvy. První, nižší, je originál, 

obvykle nazvaná Background (Pozadí). Druhá vznikla jako výsledek 
kolorizace: Layer 1 (Vrstva 1) 

○ Pomocí ikonky oka lze přepínat mezi zobrazením vrstev (zobrazují se odshora 
dospod, je možné je pomocí myši (drag and drop) vyměnit). Pomocí ikonky 
koše lze vrstvu smazat.  

○ Kliknutím pravého tlačítka myši a volbou Duplikovat vrstvu můžete vytvořit 
duplikát vhodný k libovolným experimentům s vyvážením barev.  

○ Pro další úpravu se ujistěte, že je vybrána kolorovaná vrstva. 
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2. Přizpůsobení obrazu: 
○ Výběrem  Window > Adjustment (Obraz > Přizpůsobení) můžete přistoupit 

k obdobným úpravám. Zde se krom jiných nachází především dvě vhodné 
položky, a to Vyvážení barev a Fotografický filtr.  

○ Vyvážení barev má obdobný účel jako v Neurálním filtru. Zde se však jedná a 
deterministickou (a tedy i rychlou) metodu. Vyvážení je vhodné k rychlému 
testování a finální úpravě.    

Tipy pro Použití 

1. Zpět 
○ Veškeré akce lze vzít zpět volbou Úpravy > zpět, případně zkratkou Ctrl + Z.  

2. Vrstvy 
○ Kdykoliv se můžete vrátit k práci na původním obrazu smazáním nepotřebné 

vrstvy, vybráním původního obrázku a kolorizací. 
○ Kliknutím pravého tlačítka myši a volbou Duplikovat vrstvu můžete vytvořit 

duplikát vhodný k libovolným experimentům s vyvážením barev.  
3. Kvalita vstupního obrazu: 

○ Vyberte černobílou fotografii s vysokým rozlišením a dobrou kvalitou. Vyšší 
kvalita vstupního obrazu zajišťuje lepší výsledky kolorizace. 

4. Experimentujte s různými nastaveními: 
○ Nebojte se experimentovat s různými profily a posuvníky, abyste našli ideální 

kombinaci pro váš obrázek. Vždy zálohujte původní data.  
5. Použití adjustačních vrstev: 

○ Pro jakoukoli práci můžete přidat další adjustační vrstvy (např. Hue/Saturation, 
Color Balance) pro další jemné doladění barev a tónů. 

6. Pravidelná kontrola výsledků: 
○ Průběžně kontrolujte výsledky a porovnávejte je s původní fotografií, aby byl 

zajištěn realistický a vyvážený vzhled. 
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4.2.3 Shrnutí 

Použití neurálních filtrů ve Photoshopu pro automatickou rekonstrukci fotografií, kombinované 
s manuálními korekcemi, je efektivní způsob, jak dosáhnout vysoce kvalitních výsledků při 
obnově starých a poškozených fotografií. Tento postup umožňuje využít pokročilé technologie 
umělé inteligence k rychlému vylepšení obrazu a následně provést jemné doladění pomocí 
manuálních technik, čímž se dosáhne profesionálního vzhledu a zachování historické hodnoty 
fotografií. 

Pro manuální úpravu doporučujeme použít nástroj Photoshopu - vrstvy, který umožní snadno 
provádět nedestruktivní editace, porovnávat postupy, či se vracet v procesu retušování. 

Postup A1 i A2 pracuje s daty, které jsou přítomny v dané fotografii. Použité postupy jsou buď 
deterministické, nebo vycházejí přímo z okolí poškozených částí (např. mediánový filtr). To je 
hlavní rozdíl oproti dalšímu postupu A3.  

Zároveň je vhodné říci, že postup A2 je nejen nejsložitější, ale i nejméně využívaný. Na většinu 
retuší postačuje postup A1, nebo A3. 
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4.3 Postup A3: Manuální retuš pomocí AI nástrojů generativního 
obsahu 

Rekonstrukce starých fotografií může být výrazně zlepšena použitím pokročilých nástrojů pro 
generativní obsah, které využívají umělou inteligenci (AI). Tyto nástroje umožňují efektivní 
manuální retuš, která kombinuje automatické algoritmy s přesnou kontrolou uživatele. 
Následující kapitola podrobně popisuje postup pro manuální retuš pomocí AI nástrojů 
generativního obsahu, včetně konkrétních kroků a technik, které lze použít pro dosažení 
nejlepších výsledků. Metodou lze opravit největší chyby fotografie tak, aby ji bylo možné 
opravit automaticky, případně je následně kolorovat.  

Úvod k AI nástrojům generativního obsahu 

AI nástroje generativního obsahu, jako jsou Adobe Photoshop's Content-Aware Fill, Inpainting 
a další, využívají pokročilé algoritmy strojového učení k automatickému vyplňování a opravě 
poškozených oblastí na fotografiích. Tyto nástroje analyzují okolní pixely a generují realistické 
textury a detaily, které odpovídají zbytku obrazu. Výsledkem je přesnější a přirozenější 
oprava, která vyžaduje méně manuálního zásahu. 

Zároveň je vhodné zdůraznit, že Neurální filtr vytváří obsah nejen ne základě dat okolí, ale i 
na základě obrovské trénovací množiny dat. Ač umožňuje nahradit celé nemalé oblasti obrazu 
obsahem, který na základě analýzy okolí a předchozích dat jsou pro tu oblast, jde jen o odhad 
a pravděpodobný obsah. Nejedná se o historická, nebo přesná data. Jen o pravděpodobné, 
byť často velmi kvalitní, odhady.    

4.3.1 Postup 

Krok 1: Otevření fotografie ve Photoshopu 

1. Spusťte Adobe Photoshop: 
○ Otevřete aplikaci Adobe Photoshop na vašem počítači. 

2. Otevření fotografie: 
○ Přejděte na File > Open a vyberte fotografii, kterou chcete rekonstruovat. 

Krok 2: Předběžná analýza fotografie 

1. Analýza stavu fotografie: 
○ Prohlédněte si fotografii a identifikujte oblasti, které vyžadují opravu, jako jsou 

škrábance, trhliny, chybějící části a jiné poškození. 
2. Vytvoření kopie vrstvy: 

○ Vytvořte kopii původní vrstvy (pravým kliknutím na vrstvu a výběrem Duplicate 
Layer), abyste mohli porovnat opravy s původním obrazem. 

○ Nepřeskakujte tento krok! Průběžně vytvářejte nové vrstvy pro zálohování 
postupu retuše.  

Krok 3: Použití nástroje Content-Aware Fill 
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1. Výběr poškozené oblasti: 
○ Vyberte poškozenou oblast pomocí nástroje Lasso Tool (L), který se 

nachází v panelu vlevo.   
i. V případě jasně definovaných objektů (například člověk, či 

auto), lze využít poloautomatický nástroj Výběr objektu (W). 
Nástroj využívá výběr pomocí obdélníku. Vyberte oblast tak, 
aby nežádoucí objekt byl zcela uvnitř. Po puštění tlačítka myší 
se oblast přepočítá a vybere pouze objekt.  . 

○ Myší obkružte chybějící, či poškozenou oblast. Obkružte i část původních dat. 
jakmile pustíte tlačítko myši, oblast se uzavře a uvidíte animovaný výběr.    

○ U oblasti se zobrazí panel generativní výplně.  

 

2. Aplikace Content-Aware Fill: 
○ Pokud se panel nezobrazí, zapnete jej 

volnou Edit > Fill (Úpravy > Generativní 
výplň). 

○ Klikněte na „Generativní výplň“ a následně 
na “Generovat” pro aplikaci opravy. 

3. Kontrola výsledků: 
○ Algoritmus vytvoří tři různé možná opravy 

vybrané oblast, mezi kterými můžete volit 
pomocí “<” a “>”, zvolené číslo opravy je 
zobrazené vedle jako “2 / 3” apod.  

○ Opětovným kliknutím na “generovat” 
vytvoříte další tři možní opravy. Proces 
opakujte dokud nebudete spokojeni.  

i. Pokud nejste spokojeni ani po několika iteracích, znovu vybrat oblast a 
použijte těsnější obkroužení.    

○ Zkontrolujte opravenou oblast a případně zopakujte proces, pokud je třeba 
provést další úpravy. 

○ Pro retušování historických fotek se vyvarujte zadávání textu (viz kapitolu 
Generativní výplň níže) 
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Opakujte s každou problematickou oblastí. Každá aplikace vytváří novou vrstvu, které 
překrývá původní obrázek. Jednotlivé vzorky můžete v panelu Vrstvy (Layers), který zapnete 
pomocí F7 skrývat a porovnávat kvalitu retuše.   

 

 

Dbejte na to, aby se jednotlivé opravy nepřekrývaly! Pokud je vadných oblastí více u sebe, 
obkružte je najednou (vlevo původní poškozená fotografie, vpravo po aplikaci filtru) 

Krok 4: Použití nástroje Healing Brush a Clone Stamp (volitelné) 

Drobné chyby a finalizace je možné opravit čistě manuálně. Tento proces není složitý, ale je 
časově velmi náročný. 

1. Healing Brush Tool: 
○ Vyberte Healing Brush Tool (J). 
○ Nastavte velikost a tvrdost štětce podle velikosti poškozené 

oblasti. 
○ Držte Alt a klikněte na čistou oblast poblíž poškozené části pro 

nastavení zdroje. 
○ Malujte přes poškozenou oblast pro její opravu. 
○ Štětec kopíruje texturu ze zdrojové oblasti. Je vhodný pro částečně náhodné 

oblasti s opakující se strukturou jako jsou stěny, tráva a podobně.  
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2. Clone Stamp Tool: 
○ Vyberte Clone Stamp Tool (S). 
○ Nastavte velikost a tvrdost štětce. 
○ Držte Alt a klikněte na čistou oblast pro nastavení zdroje 

klonování. 
○ Malujte přes vady, abyste je odstranili. 
○ Štětec kopíruje přesně kusy obrazu. Je vhodný pro repetitivní oblasti, jako 

jsou střechy, dlažba a podobně.   

Krok 5: Sloučení vrstev (volitelné) 

Je důležité si uvědomit, že po tomto kroku bylo vytvořeno několik nových vrstev. Náhled 
výsledku je kombinací těchto vrstev, kdy celá fotografie se nachází nejníže a je na konkrétních 
místech překryta malými opravenými vzorky.  

Pokud chcete nyní pracovat s obrazem jako s celkem, je potřeba tyto vrstvy sjednotit.  

 

1. Panel Vrstvy - vytvoření a duplikace skupiny 
○ Klávesou F7 zobrazte panel vrstvy 
○ Pomocí levého tlačítka myší a klávesy Shift vyberte všechny vrstvy.  
○ Pomoci Ctrl+G vytvoříte z vrstev jednu skupinu.  
○ Klikněte pravým tlačítkem myší na “Duplikova skupinu” 

2. Panel Vrstvy - sloučení skupiny 
○ Kliknete na nově vytvořenou skupinu (je výše) a vyberte možnost Sloučit 

skupinu (Ctrl + E) 

 

Nyní máte jak zálohovaná původní data, tak sloučenou vrstvu, s kterou můžete pracovat jako 
s celkem. Duplikační krok není nezbytný, ale je velmi doporučený pro další práci.  
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Krok 6: Korekce barev a kontrastu 

1. Histogramové úpravy: 
○ Otevřete Image > Adjustments > Levels. 
○ Upravte vstupní a výstupní úrovně pro zlepšení kontrastu a tonalit. 
○ Pokud histogram není plně rozprostřen mezi minimální hodnotou (bílá) a 

maximální (černá), pohněte s krajními šipkami pod histogramem tam, aby úžeji 
obepnuly histogram. 

i. Dojde k přepočti úplně bílé a úplně černé barvy v obraze. vzhledem k 
povaze historických fotografií je obvykle vhodné, aby obsahovaly oba 
extrémy (např. obloha vs. stín).  

ii. Přepočet je lineárním vzorkováním.  

 

2. Křivky (Curves): 
○ Otevřete Image > Adjustments > Curves. 
○ Upravte křivky pro jemné doladění barev a kontrastu. 
○ Podobného výsledku lze dosáhnout i pomocí křivek. Křivný nabízí nelineární 

přepočet světlosti a umožňuje například více zvýraznit tmavé oblasti při 
ponechání světlých.  

○ Význam křivky v histogramu je přepočtový: Spodní hodnoty (osa x) jsou vstupní 
a převádí vynesením na křivky na hodnoty osy y. 
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Ukázka funkce křivek. Na obou křivkách se více tmavých barev převádí na plně černou. na 
křivce vpravo pak dochází k nelineárnímu přepočtu světlých oblastí.  

Krok 7: Uložení a export 

1. Uložení práce: 
○ Uložte soubor ve formátu PSD, abyste zachovali všechny vrstvy a možnost 

budoucích úprav (File > Save As). 
2. Export hotové fotografie: 

○ Exportujte hotový obraz do formátu JPEG nebo PNG pro sdílení nebo archivaci 
(File > Export > Export As). 
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4.3.2 Příklady použití 

 
Ukázka postupného odstraňování nežádoucích objektů a vytvoření nezastíněného objektu. 

Výsledná fotka je připravena ke kolorizaci a k použití pro fotogrammetrii. 
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Ukázka provedená retuše dle postupu výše.  
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Ukázka kombinace automatické a manuální retuše (automatická retuš pro odstranění 

hlavních vad, manuální pro pravou sekci obrazu) 
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Ukázka komplexnější retuše: Odstranění škrábanců, inpainting nežádoucích objektů, a 
následná ekvalizace obrazu, 
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4.4 Postup A4: Plně automatické rekonstrukce v Bringing-Old-
Photos-Back-to-Life 

Tento postup využívá open-source software popsaný v kapitole 6.1 Vylepšení fotek pomocí 
předučené neuronové sítě. Jedná se software ovládaný z linuxového terminálu využívající 
naučené neuronové sítě běžící na vlastním hardwaru. Počáteční instalace a použití je pro 
nezkušené uživatele trochu komplikované, ale následně lze plně automaticky a hromadně 
zpracovat velké množství fotek najednou. Instalace je popsána ve zmíněné kapitole. Lze od 
sebe oddělit kroky pro detekci a retuš poškození fotek a pro celkové zlepšení kvality fotek. 

4.4.1 Postup (jen vylepšení kvality) 

Krok 1: Zmenšení rozlišení 

Rozlišení fotek zmenšíme tak, aby delší ze stran neměla víc než 5000 pixelů. Pro zmenšení 
fotek je možno použít například Malování v MS Windows (manuální zmenšení po jedné fotce) 
nebo pro dávkové zpracování například XN View MP. Zmenšení rozlišení je třeba hlavně z 
důvodu paměťové náročnosti dalších kroků na grafickou kartu. 

Krok 2: Umístění fotek do zdrojové složky 

Všechny zdrojové fotky ve formátu png, jpg nebo tiff nakopírujeme do složky data-img (viz 
instalace). 

Krok 3: Spuštění algoritmu 

Spustíme skript restore, který provede dávkové zpracováni fotek. Samotné zpracování jedné 
fotky trvá cca 15 - 60 s v závislosti na velikosti (rozlišení). Skript restore provede úpravy barev 
a ostrosti fotek, doladí některé detaily fotek. 

Krok 4: Kontrola výsledků 

Výstup bude ve složce output. 

4.4.2 Postup (vylepšení kvality a odstranění poškození) 

Kroky 1 a 2 stejné jako v kapitole 4.4.1. 

Krok 3: Spuštění algoritmu 

Spustíme skript scratch_restore, který provede zpracováni fotek. Samotné zpracování jedné 
fotky trvá cca 20 - 120 s v závislosti na velikosti (rozlišení). Skript scratch_restore  nejprve 
detekuje poškození a vytvoří masku, následně provede jejich odstranění a nakonec provede 
úpravy barev a ostrosti fotek, doladí některé detaily fotek. 

Krok 4: Kontrola výsledků 

Výstup bude ve složce output2. 
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4.4.3 Výsledky algoritmu 

Porovnání vstupu a výstupu toho algoritmu je uvedeno v kapitolách 6.1.3 Výsledky úprav 
(verze bez odstranění poškození) a 6.1.4 Výsledky úprav (verze s odstraněním škrábanců).  
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5. Kolorizace 
Kolorizace starých černobílých fotografií je fascinující proces, který umožňuje převést staré 
černobílé snímky do moderního barevného formátu. Tento proces nejen přináší nový život 
historickým fotografiím, ale také umožňuje lepší porozumění a emocionální propojení s 
minulostí. S rozvojem technologie a umělé inteligence (AI) se kolorizace stala dostupnější a 
snadnější než kdy dříve. Dnes existuje několik online nástrojů a webových stránek, které 
umožňují uživatelům automaticky kolorizovat své černobílé fotografie. 

Nejdříve porovnáme dostupné nástroje, vybereme ty nejvhodnější a vytvoříme a popíšeme 
podrobně ideální postup pro kolorování starých fotografií. Technický postup si klade za cíl to, 
aby krok po kroku popsal způsob kolorizace fotografií, a to včetně výběru technologie - ať už 
podle schopností uživatele, nebo například možnosti použít placený nástroj.  

Tato kapitole se věnuje především nástrojům pro nezkušené uživatele, kteří pomocí tohoto 
technického postupu budou schopni kolorovat staré fotografie tak, jak je uvedeno například v 
následujícím příkladu: 

 

Ukázka (automatické) kolorizace 

5.1 Základní nástroje pro kolorizaci fotografií 

Existuje několik populárních a efektivních webových nástrojů, které umožňují kolorizaci 
fotografií pomocí pokročilých algoritmů strojového učení. Tyto nástroje analyzují černobílé 
fotografie a aplikují na ně realistické barvy na základě rozsáhlých tréninkových dat. Ty 
nejvýznamnější nástroje jsou: 

Colourise.com 

● Colourise.com je jednoduchý a efektivní nástroj, který využívá umělou inteligenci k 
automatické kolorizaci fotografií. Jeho výhodou je rychlost a snadné použití, 
nevýhodou může být omezené přizpůsobení výsledků. 

● Nabízí velmi omezení použití online zdarma 
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Img2Go 

● Img2Go nabízí širokou škálu nástrojů pro úpravu obrázků, včetně kolorizace. Tento 
nástroj je vhodný pro uživatele, kteří chtějí více možností přizpůsobení a úprav. 
Nevýhodou může být složitější rozhraní pro začátečníky. 

● Nabízí zdarma licence pro učitele a studenty 

DeOldify 

● DeOldify je open-source projekt, který poskytuje vysoce kvalitní kolorizaci díky 
pokročilým algoritmům strojového učení. Tento nástroj může být použit online 
prostřednictvím různých platforem nebo lokálně po stažení a instalaci. Výhodou je 
vysoká kvalita výstupu, nevýhodou může být složitější nastavení pro lokální použití. 

● Online verze projektu se úzce svázaná s projektem MyHeritage a její online použití tak 
není snadné.   

DeepAI Colorizer 

● DeepAI Colorizer využívá pokročilou technologii umělé inteligence pro kolorizaci 
černobílých fotografií. Tento nástroj je známý svou vysokou kvalitou a přesností 
kolorizace. Jeho výhodou je rychlý a jednoduchý proces, nevýhodou může být 
omezené možnosti pro úpravu výsledků. 

5.1.1 Výhody a omezení online nástrojů pro kolorizaci 

Výhody: 

1. Snadnost použití: 
○ Většina online nástrojů pro kolorizaci je navržena tak, aby byla uživatelsky 

přívětivá a snadno použitelná i pro úplné začátečníky. Uživatelé často potřebují 
pouze nahrát černobílý obrázek a nástroj se postará o zbytek. 

2. Rychlost: 
○ Online nástroje jsou obvykle rychlé a dokáží kolorizovat fotografie během 

několika sekund až minut. 
○ Výpočet probíhá na serverové straně a rychlost tedy není omezena hardwarem 

uživatele. 
3. Dostupnost: 

○ Tyto nástroje jsou dostupné zdarma nebo za nízký poplatek, což je činí 
přístupnými pro širokou veřejnost. 

4. Automatizace: 
○ Díky použití AI a strojového učení mohou tyto nástroje automaticky aplikovat 

realistické barvy bez potřeby manuálního zásahu. 

Omezení: 

1. Omezené přizpůsobení: 
○ Některé nástroje mohou nabízet omezené možnosti pro ruční přizpůsobení 

výsledků, což může být nevýhodou pro uživatele, kteří chtějí větší kontrolu nad 
finální podobou kolorizovaného obrázku. 
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○ Některé platformy mohou omezovat velikost vstupu např. maximálním 
rozlišením.  

2. Kvalita výstupu: 
○ Kvalita kolorizace může kolísat v závislosti na složitosti obrázku a 

schopnostech algoritmu. Některé obrázky mohou být kolorizovány lépe než 
jiné. 

3. Závislost na internetu: 
○ Online nástroje vyžadují připojení k internetu, což může být omezení pro 

uživatele s pomalým nebo nespolehlivým připojením. 
○ Problematická je i kolorizace fotek s velkým rozlišením.  

4. Bezpečnost a soukromí: 
○ Nahrávání osobních fotografií na online platformy může vzbuzovat obavy 

ohledně bezpečnosti a ochrany soukromí. Uživatelé by měli vybírat 
důvěryhodné a zabezpečené služby. Je vhodné si důkladně přečíst licenční 
podmínky (např. u DeOldify na platformě MyHeritage). 
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Příklady Výstupů  

 

Příklad 1, Kolorováno pomoci Img2Go, hlavní parametr 35  
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Příklad 2, Kolorováno pomoci DeepAI  
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Příklad 3, vlevo originál, uprostřed Img2Go, vpravo DeepAI 

   

Příklad 4, Kolorováno pomoci Img2Go, hlavní parametr 35 

 

Příklad 5, Kolorováno pomoci Img2Go, hlavní parametr 35 
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5.1.2 Vybrané Metody 

Kolorizace černobílých fotografií je proces, který může být realizován pomocí různých metod 
a nástrojů. Pro snadnou kolorizaci byly vybrány tři klíčové metody: Colourise.com, Img2Go 
a DeepAI Colorizer. Tyto metody byly vybrány na základě jejich jednoduchosti použití, kvality 
výstupu a dostupnosti pro studenty a učitele. Níže je podrobný popis těchto metod, jejich 
výhod a omezení. 

Colourise.com 

Colourise.com je webový nástroj, který využívá umělou inteligenci k automatické kolorizaci 
černobílých fotografií. Tato metoda byla vybrána pro svou triviálnost a jednoduché použití, což 
ji činí ideální pro rychlé a snadné oživení historických snímků. 

Výhody: 

● Snadné použití: Colourise.com je navržen tak, aby byl uživatelsky přívětivý, což 
umožňuje i začátečníkům snadno kolorizovat své fotografie. 

● Rychlost: Proces kolorizace je velmi rychlý, často trvá jen několik sekund až minut. 

Omezení: 

● Velikost vstupu: Jedním z hlavních omezení Colourise.com je jeho omezená velikost 
vstupních souborů (5MB, 1200x1200px). Uživatelé mohou nahrát pouze fotografie do 
určité velikosti, což může být limitující pro vysoce kvalitní skeny historických snímků. 

● Omezené přizpůsobení: Nástroj neposkytuje mnoho možností pro přizpůsobení 
barev nebo jemné doladění výsledků, což může být nevýhoda pro pokročilejší 
uživatele hledající větší kontrolu nad finální podobou kolorizovaných obrázků. 

Img2Go 

Img2Go byl vybrán jako ideální metoda pro kolorizaci díky své vysoké kvalitě výstupu a 
možnosti volného použití, což je obzvláště výhodné pro studenty a učitele. Tento nástroj nabízí 
širokou škálu funkcí a možností přizpůsobení, které umožňují detailní a přesnou kolorizaci. 

Výhody: 

● Vysoká kvalita výstupu: Img2Go poskytuje vynikající výsledky díky pokročilým 
algoritmům pro kolorizaci. Výstupy jsou detailní a realistické. 

● Široká škála funkcí: Nástroj nabízí mnoho možností pro úpravy, včetně jemného 
doladění barev, jasu, kontrastu a dalších parametrů, což umožňuje uživatelům 
dosáhnout požadovaného výsledku. 

● Dostupnost pro vzdělávání: Img2Go je dostupný zdarma, což ho činí ideálním 
nástrojem pro vzdělávací účely. Studenti a učitelé mohou tento nástroj využívat bez 
finančních omezení. 

Omezení: 

● Složitější rozhraní: Pro začátečníky může být rozhraní Img2Go trochu složitější na 
pochopení ve srovnání s jednoduššími nástroji, jako je Colourise.com. 
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DeepAI Colorizer 

DeepAI Colorizer byl vybrán jako druhá nejlepší doporučená alternativa díky své vysoké 
kvalitě výstupu a pokročilým možnostem kolorizace. Tento nástroj využívá pokročilou 
technologii umělé inteligence k dosažení co nejpřesnějších a nejrealističtějších výsledků. 

Výhody: 

● Vysoká přesnost: DeepAI Colorizer je známý svou schopností přesně kolorizovat 
černobílé fotografie s realistickými barvami. Jeho pokročilé algoritmy jsou schopny 
rozpoznat různé objekty a aplikovat na ně vhodné barvy. 

● Jednoduché použití: Přestože je DeepAI Colorizer velmi výkonný, jeho použití je stále 
jednoduché, což umožňuje uživatelům rychle a efektivně kolorizovat své fotografie. 

Omezení: 

● Omezené možnosti přizpůsobení: Podobně jako Colourise.com, i DeepAI Colorizer 
nabízí omezené možnosti pro ruční přizpůsobení výsledků. Uživatelé, kteří hledají 
větší kontrolu nad výsledkem, mohou považovat toto za nevýhodu. 

5.1.3 Rozhodovací strom online kolorizaci 

Vybrané metody pro kolorizaci černobílých fotografií v projektu Most, město které nezaniklo 
byly pečlivě zvoleny na základě jejich jednoduchosti použití, kvality výstupu a dostupnosti. 
Colourise.com poskytuje rychlé a jednoduché řešení pro základní kolorizaci, zatímco 
Img2Go nabízí pokročilejší funkce a vysokou kvalitu výstupu, což ho činí ideálním pro 
vzdělávací účely. DeepAI Colorizer představuje vynikající alternativu díky své přesnosti a 
jednoduchosti použití. Kombinací těchto nástrojů můžeme dosáhnout optimálních výsledků při 
kolorizaci historických fotografií a jejich integraci do virtuální rekonstrukce města Most, čímž 
přinášíme historii zpět k životu pro budoucí generace: 

 

Schéma 2: Výběr jednoduché kolorizační metody pro online použití 



57 

5.1.3 Různé výsledky kolorizace různými metodami 

Kolorizace černobílých fotografií pomocí různých metod může vést k odlišným výsledkům. 
Toto je dobře ilustrováno na příkladu dvou různých kolorizací stejné historické fotografie, kde 
barva cedule nad obchodem se jednou zobrazuje jako modrá a jindy jako červená (Příklad 1 
a Příklad 2). Tento jev je způsoben několika faktory souvisejícími s algoritmy a datovými 
sadami, které různé metody používají.  

1. Algoritmy strojového učení 

Různé algoritmy: Každý nástroj pro kolorizaci používá jiný algoritmus strojového učení. Tyto 
algoritmy jsou trénovány na různých datech a mohou používat různé techniky pro přidávání 
barev. 

● Neurální sítě: Většina moderních nástrojů pro kolorizaci používá hluboké neurální 
sítě, jako jsou konvoluční neurální sítě (CNN). Tyto sítě analyzují obrazové rysy a na 
základě těchto rysů přiřazují barvy. 

● Specifické předtrénované modely: Některé algoritmy mohou být předtrénovány na 
specifických typech obrázků, což ovlivňuje výsledky. Například algoritmus trénovaný 
na fotografiích přírody může přidávat jiné barvy než algoritmus trénovaný na 
historických městských snímcích. 

2. Datové sady pro trénink 

Různé datové sady: Algoritmy strojového učení jsou trénovány na rozsáhlých datových 
sadách barevných fotografií, které slouží jako reference pro kolorizaci. 

● Rozmanitost dat: Kvalita a rozmanitost datové sady mohou významně ovlivnit 
výsledky. Algoritmus trénovaný na různorodé datové sadě a na datech podobného 
typu jako jsou fotografie k obarvení, bude pravděpodobně lépe schopen generovat 
realistické a přesné barvy. 

○ Některé metody přímo nabízí konkrétní přetrénované modely a sady dat, které 
jsou výhodnější na konkrétní typy fotografií.   

● Historické reference: Některé nástroje mohou být trénovány na datových sadách, 
které obsahují historické reference, což jim umožňuje lépe zachytit autentické barvy 
pro dané období - například typické barvy cedulí pro dané historické období. Jiným 
ikonickým příkladem může být červeno-modro-bíle cedule značící holičství. 

3. Kontextuální porozumění 

Kontext obrázku: Algoritmy používají kontext obrázku k rozhodování o barvách. Pokud je 
kontext nejednoznačný nebo neobsahuje dostatek informací, algoritmus může použít různé 
barvy. 

● Omezené informace: Pokud je například cedule na obrázku černobílá a neexistují 
žádné jasné vizuální stopy, algoritmus může přiřadit barvu na základě 
nejpravděpodobnějšího scénáře podle svého tréninku. 
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4. Parametry a předvolby uživatele 

Uživatelské nastavení: Některé nástroje umožňují uživatelům upravovat parametry 
kolorizace, což může vést k různým výsledkům. 

● Manuální zásahy: Pokud uživatel upravuje barvy manuálně, může to vést k různým 
interpretacím stejné scény. 

● Automatické nastavení: Automatické nástroje mohou použít přednastavené 
parametry, které nemusí být vždy vhodné pro všechny obrázky. 

● V případě pokročilejších modelů: je možné uživatelsky zadat některé barvy - 
například známou barvu fasády, cedule, či auta.  

Příklad: DeepAI vs. Img2Go 

V uvedených příkladech: 

1. Modrá cedule: Algoritmus mohl rozhodnout, že modrá je pravděpodobnější barva na 
základě svého tréninku na datové sadě, která obsahovala více modrých cedulí v 
podobných kontextech. 

2. Červená cedule: Jiný algoritmus mohl mít tréninkovou datovou sadu, která 
obsahovala více červených cedulí nebo mohla použít jinou heuristiku k rozhodnutí o 
barvě. 

Různé výsledky kolorizace černobílých fotografií jsou bohužel běžným jevem způsobeným 
variabilitou algoritmů, datových sad a kontextuálních interpretací. Při použití těchto základních 
nástrojů je důležité mít na paměti, že výsledky mohou být subjektivní a že konečný výstup 
může být ovlivněn mnoha faktory. Proto může být užitečné porovnat více metod a případně 
provést manuální úpravy pro dosažení co nejpřesnějších a nejrealističtějších výsledků. 

5.1.4 Přínosy Kolorizace v projektu Most, město které nezaniklo. 

Jako příklad využití kolorizace fotografií můžeme uvést projekt "Most, město které nezaniklo". 
Tento projekt si klade za cíl znovuvytvoření původního města Most ve virtuální realitě (VR) 
pomocí fotogrammetrie a 3D modelování. Most, historické město, které bylo z velké části 
zničeno během 20. století, je ideálním kandidátem pro tento typ historické rekonstrukce. 

Využití Kolorizace v Projektu Most, město které nezaniklo 

V rámci projektu budou použity černobílé fotografie starého města jako primární zdrojový 
materiál. 

Kolorizace fotografií v projektu Most, město které nezaniklo má několik klíčových přínosů: 

1. Oživení Historie: Barevné fotografie umožňují lepší vizualizaci a porozumění 
historickým událostem a každodennímu životu ve starém Mostu. 

2. Vzdělávací Hodnota: Kolorizované fotografie byly použity ve vzdělávacích 
materiálech a výstavách, což pomohlo vzdělávat veřejnost o historii města. 

3. Kulturní Zachování: Projekt přispěl k zachování kulturního dědictví tím, že historické 
fotografie byly převedeny do moderního formátu, který je atraktivní pro širší publikum. 
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Kolorizace černobílých fotografií je tedy nejen technickým procesem, ale také prostředkem 
pro kulturní a historické zachování. Projekty jako Most, město které nezaniklo, ukazují, jak 
mohou moderní technologie a umělá inteligence přispět k oživení naší minulosti a umožnit 
nám lépe porozumět našemu kulturnímu dědictví. 

Rekonstrukce ve Virtuální Realitě 

Kolorizované fotografie budou sloužit jako základ pro vytvoření 3D modelů budov a ulic ve 
virtuální realitě. Proces rekonstrukce bude zahrnovat následující kroky: 

1. Fotogrammetrie 
○ Pomocí kolorizovaných fotografií a fotogrammetrických technik budou 

vytvořeny přesné 3D modely historických budov a ulic. Tento proces zahrnuje 
identifikaci klíčových bodů na fotografiích a jejich přeměnu na trojrozměrné 
body, které budou následně spojeny do celkových modelů. 

2. 3D Modelování 
○ 3D modeláři budou využívat kolorizované fotografie jako reference pro detaily 

a textury modelů. To zajistí, že výsledné 3D modely budou nejen přesné, ale 
také esteticky věrné historické skutečnosti. 

3. Implementace ve VR 
○ Finální modely budou integrovány do VR prostředí, což umožní uživatelům 

procházet se původním městem Most a zažít jeho atmosféru tak, jak vypadala 
před zničením. VR technologie umožní interaktivní prohlídky, kde se uživatelé 
budou moci ponořit do historického prostředí a získat lepší porozumění životu 
v minulosti. 

5.1.5 Závěr 

Kolorizace černobílých fotografií představuje nejen technologický pokrok, ale také významný 
kulturní a historický přínos. Tento proces umožňuje převést staré, často zapomenuté snímky 
do moderního barevného formátu, čímž oživuje vzpomínky a historické momenty, které by 
jinak mohly být zastřené. S rozvojem umělé inteligence a pokročilých algoritmů strojového 
učení se kolorizace stala dostupnou pro širokou veřejnost, což umožňuje nejen profesionálům, 
ale i amatérům oživit své rodinné alba a historické fotografie. 

Jedním z konkrétních příkladů, kde byla kolorizace využita, je projekt Most, město které 
nezaniklo. Tento projekt se zaměřuje na oživení historických fotografií Starého Mostu, města 
s bohatou historií a významným kulturním dědictvím. Použitím několika online nástrojů pro 
kolorizaci byly tyto fotografie převedeny do barevné podoby, což umožnilo lepší vizuální 
představu o minulosti města a jeho obyvatelích. 
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5.1.6 Podrobný návod na kolorizaci fotek pomocí Colourise.com 

Krok 1: Otevření webového prohlížeče a přístup na Colourise.com 

1. Otevřete webový prohlížeč: 
○ Doporučuje se používat moderní prohlížeče jako Google Chrome, Mozilla 

Firefox, Microsoft Edge nebo Safari pro optimální výkon. 
2. Přejděte na webovou stránku Colourise.com: 

○ Zadejte následující URL do adresního řádku prohlížeče: https://colourise.com/ 

Krok 2: Nahrání obrázku 

1. Nahrání obrázku z vašeho počítače: 
○ Na hlavní stránce Colourise.com klikněte na tlačítko "Upload" nebo "Choose 

Photo". 
○ Vyberte černobílý obrázek, který chcete kolorizovat, ze svého počítače. 

Podporované formáty zahrnují JPEG a PNG. 
○ Ujistěte se, že rozlišení vašeho obrázku je maximálně 1200px na 1200px 
○ Ujistěte se, že velikost vašeho obrázku je maximálně 5MB 

Krok 3: Automatická kolorizace 

1. Inicializace kolorizace: 
○ Po nahrání obrázku začne proces kolorizace automaticky. Colourise.com 

používá pokročilé algoritmy strojového učení pro analýzu a aplikaci barev na 
černobílý obrázek. 

○ Proces obvykle trvá několik sekund, v závislosti na velikosti a složitosti 
obrázku. 

Krok 4: Zobrazení výsledku 

1. Kontrola výsledku: 
○ Po dokončení procesu se zobrazí náhled kolorizovaného obrázku vedle 

původního černobílého obrázku. To vám umožní snadno porovnat výsledek s 
originálem. 

○ Zkontrolujte kvalitu kolorizace a ujistěte se, že jste s výsledkem spokojeni. 

Krok 5: Stáhnutí kolorizovaného obrázku 

1. Stažení a uložení: 
○ Pokud jste s výsledkem spokojeni, klikněte na tlačítko "Download" pro stažení 

kolorizovaného obrázku do vašeho počítače. 
○ Uložte obrázek do požadovaného adresáře. 

Tipy a Doporučení 

1. Výběr kvalitního obrázku: 
○ Používejte obrázky s vysokým rozlišením pro lepší výsledky. Nižší rozlišení 

může vést k méně kvalitní kolorizaci. 

https://colourise.com/
https://colourise.com/
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○ Proveďte základní postupy pro vylepšení fotky, jako je odstranění škrábanců, 
vyvážení histogramu a podobně.  

2. Experimentujte s různými obrázky: 
○ Pokud nejste spokojeni s výsledkem, zkuste nahrát jiný obrázek. Různé 

obrázky mohou vyžadovat různé přístupy a mohou mít odlišné výsledky. 
3. Zálohování původního obrázku: 

○ Před zahájením jakýchkoliv úprav si vždy vytvořte zálohu původního obrázku, 
abyste se mohli kdykoliv vrátit k originálu. 

4. Dodatečné úpravy: 
○ Pokud chcete provést další úpravy kolorizovaného obrázku, můžete použít 

další grafické editory, jako je Adobe Photoshop (placený) nebo GIMP 
(neplacený), pro jemné doladění barev, kontrastu a dalších parametrů. 

5. Kompatibilita formátů: 
○ Ujistěte se, že obrázek, který chcete kolorizovat, je ve formátu podporovaném 

Colourise.com  

Poznámky k technologii 

● Strojové učení a AI: 
○ Colourise.com využívá technologii strojového učení a umělé inteligence pro 

analýzu černobílých obrázků a aplikaci realistických barev. Tyto algoritmy jsou 
trénovány na velkých sadách dat, aby dokázaly rozpoznat různé objekty a jejich 
typické barvy. Fungují dobře na fotkách lidí, přírody a architektury, v jiném 
případě může kvalita kolorizace silně kolísat.  

● Cloudová služba: 
○ Proces kolorizace je prováděn na serverech Colourise.com, což znamená, že 

výpočetní výkon vašeho zařízení není omezujícím faktorem. To umožňuje 
rychlé a efektivní zpracování i u složitějších obrázků. 
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5.1.7 Podrobný návod na kolorizaci fotek pomocí Img2Go 

Krok 1: Otevření webového prohlížeče a přístup na Img2Go 

1. Otevřete webový prohlížeč: 
○ Doporučuje se používat moderní prohlížeče jako Google Chrome, Mozilla 

Firefox, Microsoft Edge nebo Safari pro optimální výkon. 
2. Přejděte na webovou stránku Img2Go1: 

○ Zadejte následující URL do adresního řádku prohlížeče: 
https://www.img2go.com 

Krok 2: Výběr nástroje pro kolorizaci fotek 

1. Navigace na hlavní stránce: 
○ Na hlavní stránce Img2Go můžete vidět několik různých kategorií a nástrojů. V 

kategorii "Barva" nebo "Color" vyberte možnost "AI Colorize."  

Krok 3: Nahrání obrázku 

1. Nahrání obrázku z různých zdrojů: 
○ Klikněte na tlačítko "Vybrat soubor" (Choose File) pro nahrání obrázku z 

vašeho počítače. 
○ Alternativně můžete nahrát obrázek z Dropboxu, Google Drive, nebo vložením 

URL odkazu. 
○ Podporované formáty zahrnují JPEG, PNG, BMP a další běžné formáty 

obrázků. 
i. Doporučujeme formát PNG 

Krok 4: Nastavení parametrů kolorizace 

1. Přizpůsobení parametrů: 
○ Po nahrání obrázku se vám zobrazí možnosti pro úpravu parametrů kolorizace. 
○ Vyberte algoritmus nebo styl kolorizace, pokud je tato možnost k dispozici. 

i. Pro prezentované výsledky a projekt Most, město které nezaniklo byly 
jako ideální parametry detekovány: 

1. Nature and People jako trénovací model 
2. 35 jako render faktor. 

○ U některých nástrojů můžete nastavit intenzitu barev, jas, kontrast nebo 
specifické barevné tóny. 

Krok 5: Spuštění procesu kolorizace 

1. Inicializace kolorizace: 
○ Klikněte na tlačítko "Start" nebo "Kolorizovat" (Colorize) pro spuštění procesu. 

                                                
1 Služba je placená: 
Premium: 5,5€* / měsíc 60 retuší a barvení = 0,0916666667€ za každou kolorizace 
Business: 19,5€ / měsíc 400 retuší a barvení = 0,04875€ za 1 kolorizace  
Enterprise: 64€ / měsíc 1600 retuší a barvení = 0,04€ za 1 kolorizace 
Tarif Premium je zdarma pro učitele a studenty.  

https://www.img2go.com/
https://www.img2go.com/
https://www.img2go.com/
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○ Proces může trvat několik sekund až minut v závislosti na velikosti a složitosti 
obrázku. 

○ Během tohoto procesu server Img2Go používá pokročilé algoritmy pro analýzu 
a aplikaci barev na černobílý obrázek. 

Krok 6: Stáhnutí kolorizovaného obrázku 

1. Kontrola výsledku: 
○ Po dokončení procesu se zobrazí náhled kolorizovaného obrázku. 
○ Zkontrolujte výsledek, zda odpovídá vašim očekáváním. 

2. Stažení a uložení: 
○ Klikněte na tlačítko "Stáhnout" (Download) pro stažení upraveného obrázku do 

vašeho počítače. 
○ Uložte obrázek do požadovaného adresáře. 

Krok 7: Další úpravy (Volitelné) 

1. Dodatečné úpravy: 
○ Pokud chcete provést další úpravy obrázku, využijte další nástroje na Img2Go, 

jako je ořezávání, změna velikosti, přidání efektů nebo úprava jasu a kontrastu. 
○ Každá z těchto úprav může být provedena na samostatné vrstvě, což umožňuje 

nedestruktivní editaci. 

Tipy a Doporučení 

1. Výběr kvalitního obrázku: 
○ Používejte obrázky s vysokým rozlišením pro lepší výsledky. Nižší rozlišení 

může vést k méně kvalitní kolorizaci. 
○ V případě velmi poškozeného obrázku může být vhodné nejdříve provést 

vylepšení - například odstranění škrábanců (kap X). 
2. Experimentujte s nastaveními: 

○ Pokud nejste spokojeni s výsledkem, zkuste změnit nastavení parametrů a 
znovu spustit proces kolorizace. Různé obrázky mohou vyžadovat různé 
přístupy. 

○ Pokud jsou barvy moc mdlé, pokračujte na krok vylepšení kvality fotografie 
(Kap XY)..  

3. Použití náhledu: 
○ Vždy využívejte náhled před konečným uložením obrázku. To vám umožní 

provést potřebné úpravy bez nutnosti opětovného nahrávání obrázku. 
○ Použití náhledu obvykle neguje kreditová poplatek (ten je stržen až při stáhnutí 

výsledku). 
4. Zálohování původního obrázku: 

○ Před zahájením jakýchkoli úprav si vždy vytvořte zálohu původního obrázku, 
abyste se mohli kdykoliv vrátit k originálu. 
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5.2 Photoshop  

Neurální filtry v Adobe Photoshopu představují špičku v oblasti digitálního zpracování obrazu, 
využívající pokročilé technologie umělé inteligence (AI) a strojového učení (ML) pro 
automatizaci a zdokonalení různých úprav obrázků. Nejvhodnější možnost vyvažující vysokou 
kvalitu výsledku a přívětivost použití pro neznalé uživatele je kolorizační neurální filtr. Je 
navržen tak, aby přinesl realistické a přesné barvy do starých snímků, což umožňuje jejich 
moderní revitalizaci. 

5.2.1 Schopnosti Neurálního filtru 

Neurální filtr pro kolorizaci využívá hluboké konvoluční neurální sítě (CNN), které jsou 
trénovány na rozsáhlých datových sadách barevných fotografií. Tento trénink umožňuje filtru 
rozpoznat různé objekty a textury v černobílých fotografiích a přiřadit jim nejpravděpodobnější 
barvy. Hlavní schopnosti tohoto filtru zahrnují: 

1. Automatická analýza a detekce objektů: 
○ Filtr je schopen automaticky rozpoznat a identifikovat různé prvky na fotografii, 

jako jsou obličeje, vegetace, architektura a další objekty, a přiřadit jim vhodné 
barvy na základě naučených vzorů. 

2. Realistická rekonstrukce barev: 
○ Díky pokročilým algoritmům strojového učení filtr generuje realistické barevné 

odstíny, které odpovídají skutečnosti, čímž se zajišťuje, že kolorizované 
fotografie vypadají věrohodně a esteticky příjemně. 

3. Adaptivní učení: 
○ Filtr se neustále zdokonaluje s více daty, což znamená, že výsledky se 

postupem času zlepšují. Algoritmy se adaptují na nové vzory a textury, což 
umožňuje stále přesnější kolorizaci. 

4. Flexibilita a přizpůsobení: 
○ Neurální filtr nabízí uživatelům možnost jemného doladění výsledků, což 

umožňuje dosažení ideálního vzhledu prostřednictvím manuálních úprav a 
použití separátních vrstev. 

5.2.2 Možnosti Kolorizace 

V rámci tohoto Technického postupu budou navrženy a podrobně rozebrány tři základní 
postupy odstupňované dle uživatelské náročnosti tak, aby i nový uživatel byl schopen kvalitně 
kolorovat historické fotografie jak automaticky, tak manuálně dle tohoto navrženého 
technického postupu.  

1. Plně Automatická Kolorizace 

Popis: 

● Tento režim umožňuje uživatelům rychle a snadno aplikovat barvy na černobílé 
fotografie bez potřeby jakýchkoliv manuálních úprav. Filtr automaticky analyzuje 
obraz, rozpozná objekty a aplikuje vhodné barvy.  
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Výhody: 

● Rychlost a jednoduchost. 
● Ideální pro uživatele, kteří hledají rychlé řešení bez potřeby detailních úprav. 

2. Automatická kolorizace s manuálním doladěním 

Popis: 

● Tento režim kombinuje automatickou kolorizaci s možností jemného doladění 
výsledků. Uživatelé mohou upravit jednotlivé barvy, sytost, kontrast a další parametry 
podle svých preferencí. 

● V technickém postupu navrhneme vhodné hodnoty a doporučíme jednoduchý postup 
pro zvýšení kvality kolorizace.  

Výhody: 

● Umožňuje dosažení přesnějších a realističtějších výsledků. 
● Poskytuje kontrolu nad finálním vzhledem fotografie. 

Nevýhody: 

● Některé úpravy mohou zabrat čas vzhledem k hardwarovému vybavení počítače 

3. Automatická kolorizace s manuálním doladěním a pomocí separátní vrstvy 

Popis: 

● Tento režim nabízí nejvyšší úroveň kontroly, kde automatická kolorizace je 
kombinována s manuálním doladěním a použitím separátních vrstev pro přidání nebo 
úpravu barev. Uživatelé mohou vytvářet nové vrstvy, aplikovat barvy na specifické 
oblasti a použít maskování pro precizní úpravy. 

Výhody: 

● Maximální kontrola a flexibilita. 
● Z velké části jde stále o automatizovaný postup.  
● Možnost dosáhnout velmi živých a realistických výsledků. 

Nevýhody: 

● Některé úpravy mohou zabrat čas vzhledem k hardwarovému vybavení počítače 
● Přestože se nejedná o postup obtížný, jeho jednotlivé kroky vyžadují čas 

Neurální filtry pro kolorizaci ve Photoshopu představují výkonný nástroj, který kombinuje sílu 
umělé inteligence s flexibilitou manuálních úprav. Uživatelé mají možnost volby mezi plně 
automatickou kolorizací, automatickou kolorizací s manuálním doladěním a pokročilým 
režimem využívajícím separátní vrstvy. Každý z těchto přístupů nabízí své vlastní výhody, 
které umožňují dosáhnout optimálních výsledků při kolorizaci černobílých fotografií. Tímto 
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způsobem lze historické snímky revitalizovat a přenést je do moderního světa v živých 
barvách. 

5.3 Postup B1: Plně Automatická Kolorizace ve Photoshopu 

Neurální filtry ve Photoshopu umožňují snadnou a rychlou plně automatickou kolorizaci 
černobílých fotografií. Tento postup je ideální pro uživatele, kteří chtějí dosáhnout rychlých 
výsledků bez potřeby manuálních úprav. Níže je podrobný návod pro plně automatickou 
kolorizaci, včetně tipů pro použití a způsobu uložení výsledku. 

5.3.1 Postup 

Krok 1: Otevření fotografie 

1. Spusťte Adobe Photoshop: 
○ Otevřete program Adobe Photoshop na vašem počítači. 

2. Načtení fotografie: 
○ Otevřete (černobílou) fotografii, kterou chcete kolorizovat. Jděte na File > 

Open (Soubor > Otevřít) a vyberte soubor z vašeho počítače. 

 

Krok 2: Aktivace neurálního filtru 

1. Přístup k neurálním filtrům: 
○ V horním menu Photoshopu klikněte na Filter > Neural Filters (Filtr > Neural 

Filters). 
2. Výběr filtru Colorize: 

○ V okně Neural Filters, které se otevře, 
vyhledejte a zapněte přepínačem filtr 
Colorize (Kolorovat). 

○ Pokud provádíte tuto akci poprvé, je třeba 
daný filtr nejdříve stáhnout, to provedete 
pomocí ikonky mraku s šipkou. 

i. Filtr má zhruba 326Mb, doba jeho 
stahování je závislá na 
parametrech připojení k internetu.  
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Krok 3: Automatická Kolorizace 

1. Nastavení výstupu 
○ Ujistěte se, že jako výstup (vpravo dole) je nastavena (New layer) Nová vrstva. 

Proces bude nedestruktivní. Nedojde tedy k obarvení původní vrstvy, ale k 
vytvoření nové.  

2. Aplikace filtru: 
○ Po aktivaci filtru Colorize bude Photoshop automaticky analyzovat fotografii a 

aplikovat na ni barvy. Tento proces trvá několik sekund až minut, v závislosti 
na velikosti a složitosti fotografie. 

3. Náhled výsledku: 
○ Po dokončení procesu se vlevo zobrazí náhled kolorizované fotografie.  

 

Krok 4: Uložení Výsledku 

1. Uložení souboru ve formátu PSD: 
○ Doporučujeme uložit upravený soubor ve formátu PSD, abyste mohli případně 

provést další úpravy v budoucnu. Jděte na File > Save As (Soubor > Uložit 
jako…)  a vyberte Photoshop (*.PSD, *.PDD). 

2. Export hotové fotografie: 
○ Pro sdílení nebo tisk můžete exportovat finální kolorizovaný obrázek do 

běžného formátu, jako je JPEG nebo PNG. 
○ Jděte na File > Export > Export As. 
○ Vyberte požadovaný formát (např. JPEG nebo PNG) a nastavte kvalitu a 

rozlišení podle potřeby. 
○ Klikněte na Export a vyberte umístění pro uložení souboru. 

i. Pro rychlejší export lze zvolit možnost Fast export as PNG (Rychle 
exportovat jako PNG) z kontextového menu 
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Tipy pro Použití 

1. Kvalita vstupního obrazu: 
○ Vyberte černobílou fotografii s vysokým rozlišením a dobrou kvalitou. Vyšší 

kvalita vstupního obrazu zajišťuje lepší výsledky kolorizace. 
2. Pravidelná kontrola výsledků: 

○ Průběžně kontrolujte náhled kolorizace. Pokud nejste spokojeni s výsledkem, 
můžete zkusit další úpravy nebo použít jiný filtr. 

3. Použití různých fotografií: 
○ Experimentujte s různými fotografiemi, abyste zjistili, jak filtr funguje s různými 

typy obrázků. Některé fotografie mohou vyžadovat jemné doladění, zatímco 
jiné budou vypadat skvěle již po automatické kolorizaci. 

4. Kompatibilita a aktualizace: 
○ Ujistěte se, že máte nejnovější verzi Adobe Photoshopu. Neurální filtry jsou 

pravidelně aktualizovány a vylepšovány, což může ovlivnit kvalitu výsledků. 
5. Obsah fotografie 

○ Výsledky kolorizace jsou kvalitnější, pokud fotografie obsahuje snadno 
barvitelné části - např. oblohu, nebo zeleň.  

Plně automatická kolorizace pomocí neurálních filtrů ve Photoshopu je jednoduchý a efektivní 
způsob, jak oživit staré černobílé fotografie. Tento postup je ideální pro rychlé a snadné 
úpravy, které nevyžadují manuální zásahy. Uložením výsledku ve formátu PSD si zachováte 
možnost budoucích úprav, zatímco export do formátu JPEG nebo PNG umožní snadné sdílení 
a tisk finálního obrazu. 

5.4 Postup B2: Automatická kolorizace s jednoduchou manuální 
korekcí 

Částečně manuální kolorizace kombinuje automatické schopnosti neurálního filtru s možností 
jemného doladění výsledků. Tento postup umožňuje uživatelům provést automatickou 
kolorizaci a poté ručně upravit specifické parametry, aby dosáhli ideálního výsledku. 
Následuje podrobný návod pro částečně manuální kolorizaci, včetně tipů pro použití a 
způsobu uložení výsledku 

5.4.1 Postup 

Krok 1: Otevření Fotografie 

1. Spusťte Adobe Photoshop: 
○ Otevřete program Adobe Photoshop na vašem počítači. 

2. Načtení fotografie: 
○ Otevřete černobílou fotografii, kterou chcete kolorizovat. Jděte na File > Open 

(Soubor > Otevřít…) a vyberte soubor z vašeho počítače. 

Krok 2: Aktivace neurálního Filtru 

1. Přístup k neurálním filtrům: 
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○ V horním menu Photoshopu klikněte na Filter > Neural Filters (Filtr > Neural 
Filters). 

2. Výběr filtru Colorize: 
○ V okně Neural Filters, které se otevře, vyhledejte a zapněte filtr Colorize 

(Kolorovat). 

Krok 3: Automatická Kolorizace 

1. Aplikace filtru: 
○ Po aktivaci filtru Colorize bude Photoshop automaticky analyzovat fotografii a 

aplikovat na ni barvy. Tento proces trvá několik sekund až minut, v závislosti 
na velikosti a složitosti fotografie. 

Krok 4: Manuální Doladění 

 

1. Přizpůsobení parametrů: 
○ Po automatické kolorizaci můžete ručně doladit výsledky pomocí následujících 

parametrů v okně filtru (viz přiložený obrázek): 
○ Profil: 

■ Ponechte „Žádné.“   
○ Síla profilu: 

■ Nenastavujte.  
○ Sytost: 

■ Nastavte úroveň sytosti podle potřeby. Vyšší sytost zvýrazní barvy, 
zatímco nižší sytost je zmírní. 

■ Většina starších fotek trpí vyblednutím, je proto vhodnější nastavovat 
vyšší hodnoty. To platí i pro sépiové fotky, zde totiž taky dochází 
splývání blízkých barev, které filtr sám ekvalizuje.  

○ Azurová/červená: 
■ Upravte tento posuvník pro jemné doladění barevného posunu mezi 

azurovou a červenou a upravení teploty fotografie.  
■ Pro historické fotky není toto vyvážení příliš využitelné, lehký posun na 

červenou stranu pocitově zlepší teplotu obrázku (viz Kapitola Barevné 
modely níže)  
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○ Purpurová/zelená: 
■ Tento posuvník slouží k doladění barevného posunu mezi purpurovou 

a zelenou. Použijte ho pro dosažení vyváženějších barev. 
■ V případě výskytu vegetace je vhodné nastavení nízké kladné hodnoty 

(5-15), pro fotky měst je výhodnější naopak nízká hodnota (-10 a -20). 
○ Žlutá/modrá: 

■ Upravte tento posuvník pro doladění barevného posunu mezi žlutou a 
modrou. Posun směrem ke žluté může dodat teplejší tón, zatímco 
směrem k modré dodá chladnější tón. 

■ Upravuje teplotu fotografie. Žlutá je vhodná například pro interiéry, 
modrá naopak pro zimní scény.  

■ Doporučená hodnota pro urbanistické fotografie je  -15 až -25.  
○ Redukce barevných artefaktů: 

■ Použijte tento posuvník pro snížení nežádoucích barevných artefaktů, 
které mohou vzniknout při kolorizaci. 

■ POZOR: I nízké hodnoty mohou vést k extenzivním výpočtům. Ujistěte 
se, že nemáte neuloženou rozpracovanou práci. Poslední dvě hodnoty 
měňte až jako poslední.    

■ Pro obvyklou kolorizaci postačí nízká hodnota 5 - 10. 
○ Redukce šumu: 

■ Upravte tento posuvník pro snížení šumu v obrázku, což může zlepšit 
celkovou kvalitu fotografie. 

■ POZOR: I nízké hodnoty mohou vést k extenzivním výpočtům. Ujistěte 
se, že nemáte neuloženou rozpracovanou práci. Poslední dvě hodnoty 
měňte až jako poslední.     

■ Pro obvyklou kolorizaci postačí nízká hodnota 5 - 10. 
2. Náhled a kontrola: 

○ Průběžně kontrolujte náhled upravené fotografie a ujistěte se, že jste s 
výsledkem spokojeni. 

Krok 5: Uložení Výsledku 

1. Uložení souboru ve formátu PSD: 
○ Doporučujeme uložit upravený soubor ve formátu PSD, abyste mohli případně 

provést další úpravy v budoucnu. Jděte na File > Save As (Soubor > Uložit 
jako…)  a vyberte Photoshop (*.PSD, *.PDD). 

2. Export hotové fotografie: 
○ Pro sdílení nebo tisk můžete exportovat finální kolorizovaný obrázek do 

běžného formátu, jako je JPEG nebo PNG. 
○ Jděte na File > Export > Export As. 
○ Vyberte požadovaný formát (např. JPEG nebo PNG) a nastavte kvalitu a 

rozlišení podle potřeby. 
○ Klikněte na Export a vyberte umístění pro uložení souboru. 

i. Pro rychlejší export lze zvolit možnost Fast export as PNG (Rychle 
exportovat jako PNG) z kontextového menu 
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Krok 6: Práce s Vrstvami (volitelné) 

 

1. Panel Vrstvy: 
○ Ujistěte se, že máte otevřený panel Vrstvy (Layers). Pokud není viditelný, 

můžete jej otevřít přes Window > Layers nebo stisknutím klávesy F7. 
○ Pokud jste filtr nastavili správně, jsou vidět dvě vrstvy. První, nižší, je originál, 

obvykle nazvaná Background (Pozadí). Druhá vznikla jako výsledek 
kolorizace: Layer 1 (Vrstva 1) 

○ Pomocí ikonky oka lze přepínat mezi zobrazením vrstev (zobrazují se odshora 
dospod, je možné je pomocí myši (drag and drop) vyměnit). Pomocí ikonky 
koše lze vrstvu smazat.  

○ Kliknutím pravého tlačítka myši a volbou Duplikovat vrstvu můžete vytvořit 
duplikát vhodný k libovolným experimentům s vyvážením barev.  

○ Pro další úpravu se ujistěte, že je vybrána kolorovaná vrstva. 

 

 

2. Přizpůsobení obrazu: 
○ Výběrem  Window > Adjustment (Obraz > Přizpůsobení) můžete přistoupit 

k obdobným úpravám. Zde se krom jiných nachází především dvě vhodné 
položky a to Vyvážení barev a Fotografický filtr.  
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○ Vyvážení barev má obdobný účel jako v Neurálním filtru. Zde se však jedná a 
deterministickou (a tedy i rychlou) metodu. Vyvážení je vhodné k rychlému 
testování a finální úpravě.    

○ Fotografický filtr je jednoduchý poloautomatický filtr. Pro většinu starých 
kolorovaných fotek je ideální vybrat Warming filter (85) s Hustotou 25 procent.  

 

Tipy pro Použití 

1. Zpět 
○ Veškeré akce lze vzít zpět volbou Úpravy > zpět, případně zkratkou Ctrl + Z.  

2. Vrstvy 
○ Kdykoliv se můžete vrátit k práci na původním obrazu smazáním nepotřebné 

vrstvy, vybráním původního obrázku a kolorizací. 
○ Kliknutím pravého tlačítka myši a volbou Duplikovat vrstvu můžete vytvořit 

duplikát vhodný k libovolným experimentům s vyvážením barev.  
3. Kvalita vstupního obrazu: 

○ Vyberte černobílou fotografii s vysokým rozlišením a dobrou kvalitou. Vyšší 
kvalita vstupního obrazu zajišťuje lepší výsledky kolorizace. 

4. Experimentujte s různými nastaveními: 
○ Nebojte se experimentovat s různými profily a posuvníky, abyste našli ideální 

kombinaci pro váš obrázek. Vždy zálohujte původní data.  
5. Použití adjustačních vrstev: 

○ Pro jakoukoli práci můžete přidat další adjustační vrstvy (např. Hue/Saturation, 
Color Balance) pro další jemné doladění barev a tónů. 

6. Pravidelná kontrola výsledků: 
○ Průběžně kontrolujte výsledky a porovnávejte je s původní fotografií, aby byl 

zajištěn realistický a vyvážený vzhled. 

Částečně manuální kolorizace pomocí neurálních filtrů ve Photoshopu poskytuje flexibilitu a 
kontrolu nad finálním výsledkem, což umožňuje dosáhnout detailních a realistických barev. 
Tento postup je ideální pro uživatele, kteří chtějí automatickou kolorizaci s možností jemného 
doladění. Uložením výsledku ve formátu PSD si zachováte možnost budoucích úprav, zatímco 
export do formátu JPEG nebo PNG umožní snadné sdílení a tisk finálního obrazu. 
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5.4.2 Význam a role barevných os v kolorizaci 

Při kolorizaci fotografií pomocí nástrojů ve Photoshopu jsou barvy Azurová/červená, 
Purpurová/zelená a Žlutá/modrá klíčovými osami pro úpravy barevných tónů. Tyto barevné 
osy jsou založeny na principu komplementárních barev v barevném modelu RGB (červená, 
zelená, modrá) a jejich význam spočívá v možnosti přesně a efektivně doladit barevné 
vyvážení obrazu. 

Komplementární Barvy a Barevné Modely 

Komplementární barvy jsou páry barev, které leží naproti sobě na barevném kole. Když jsou 
kombinovány, vzájemně se vyvažují, což vytváří neutrální barvy, jako je šedá nebo bílá. V 
barevném modelu RGB jsou komplementární páry následující: 

1. Azurová/červená (Cyan/Red) 
2. Purpurová/zelená (Magenta/Green) 
3. Žlutá/modrá (Yellow/Blue) 

Tyto páry jsou také základem pro další barevné modely, jako je CMYK (Cyan, Magenta, 
Yellow, Key/Black) používaný v tisku. 

Význam Barevných Os 

1. Azurová/Červená (Cyan/Red) 

● Azurová a červená jsou komplementární barvy. 
● Význam: 

○ Červená je jednou ze základních barev v RGB modelu a je často dominantní 
v barevných fotografiích, zvláště u pleťových tónů. 

○ Azurová je komplementární barva k červené, což znamená, že její přidání 
může neutralizovat červené tóny. 

● Použití: 
○ Posuvník Azurová/červená umožňuje doladit teplotu obrázku. Pokud je obraz 

příliš červený (teplý), přidání azurové (chladné) ho může vyvážit, a naopak. 

2. Purpurová/Zelená (Magenta/Green) 

● Purpurová a zelená jsou další dvojicí komplementárních barev. 
● Význam: 

○ Purpurová je směsí červené a modré, což jí dává bohaté a živé vlastnosti. 
○ Zelená je komplementární k purpurové, což znamená, že její přidání může 

neutralizovat purpurové tóny. 
● Použití: 

○ Tento posuvník je užitečný pro vyvážení barev v obrazu, kde jsou přítomny 
zelené a purpurové prvky, jako jsou vegetace a stíny. Například přidání zelené 
může zlepšit vzhled krajiny, zatímco purpurová může být použita pro korekci 
barev u stínů nebo tmavých oblastí. 

3. Žlutá/Modrá (Yellow/Blue) 
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● Žlutá a modrá jsou poslední dvojicí komplementárních barev v tomto kontextu. 
● Význam: 

○ Žlutá je výsledkem kombinace červené a zelené v RGB modelu, což jí dává 
jasný a teplý vzhled. 

○ Modrá je komplementární k žluté, což znamená, že její přidání může 
neutralizovat žluté tóny. 

● Použití: 
○ Tento posuvník se často používá k úpravě teploty obrázku. Přidání žluté může 

dodat teplejší vzhled, což je užitečné pro západy slunce nebo interiéry. Přidání 
modré může dodat chladnější vzhled, což je vhodné pro zimní scény nebo 
stínované oblasti. 

Shrnutí 

Použití barevných os Azurová/červená, Purpurová/zelená a Žlutá/modrá v kolorizaci 
umožňuje precizní kontrolu nad barevným vyvážením obrázků. Tyto osy jsou založeny na 
principu komplementárních barev, které se vzájemně neutralizují, což umožňuje efektivní 
korekci a doladění barev. Tento přístup zajišťuje, že upravené fotografie vypadají realisticky 
a esteticky příjemně, což je klíčové pro profesionální kolorizaci a restaurování historických 
fotografií. 

5.5 Postup B3: Automatická kolorizace ve Photoshopu s 
komplexní manuální korekcí 

Kolorizace černobílých fotografií pomocí neurálních filtrů ve Photoshopu nejenže přináší 
rychlé a realistické výsledky, ale také umožňuje pokročilé doladění a přizpůsobení výsledné 
barvy pomocí manuálních úprav. Tato část popisuje postup, jak kombinovat automatickou 
kolorizaci s manuálním doladěním a využitím separátní vrstvy pro obarvení. 

V této části představíme jednoduchý, ověřený postup, pomocí kterého lze kolorovat historické 
fotky a manuálně řídit, jak samotný postup kolorizace, tak případně upravit i výslednou 
kolorizaci za pomocí pokročilé manipulace s vrstvami Photoshopu.  

5.5.1 Postup 

Krok 1: Otevření fotografie 

1. Spusťte Adobe Photoshop: 
○ Otevřete program Adobe Photoshop na vašem počítači. 

2. Načtení fotografie: 
○ Otevřete černobílou fotografii, kterou chcete kolorizovat. Jděte na File > Open 

(Soubor > Otevřít…) a vyberte soubor z vašeho počítače. 

Krok 2: Aktivace neurálního filtru 

1. Přístup k neurálním filtrům: 
○ V horním menu Photoshopu klikněte na Filter > Neural Filters (Filtry > neural 

filters). 
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2. Výběr filtru Colorize: 
○ V okně Neural Filters, které se otevře, vyhledejte a zapněte filtr Colorize 

(Kolorovat). 

Krok 3: Automatická kolorizace 

1. Aplikace filtru: 
○ Po aktivaci filtru Colorize bude Photoshop automaticky analyzovat fotografii a 

aplikovat na ni barvy. Tento proces trvá několik sekund až minut, v závislosti 
na velikosti a složitosti fotografie. 

2. Náhled výsledku: 
○ Po dokončení procesu se zobrazí (vlevo) náhled kolorizované fotografie. 

Zkontrolujte, zda jste s výsledkem spokojeni. 

Krok 4: Manuální doladění 

Manuální doladění se provádí pomocí miniatury kolorované fotografie. Umístěním 
ohniskových bodů (tzv. pinů) s pevně nastavitelnou barvou lze kolorizačnímu procesu nastavit 
konkrétní, přesnou a požadovanou barvu daného objektu.  

 

1. Použití Color Picker: 
● V případě, že chcete použít jinou barvu než tu, kterou automaticky vybral filtr, 

můžete přidat vlastní barvy. 
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○ Prozatím ponechte zvolenou možnost “Automaticky kolorovat 
obrázek” 

● Klikněte na náhled pod náhledem obrázku a vyberte požadovanou barvu. 
● Otevře se volba barvy, kterou chcete použít. Vyberte barvu, které například na 

základě historických znalostí má objekt mít.  
○ Žádaná barva se vybírá buď pomocí barevného modelu RGB, HSB, 

CMYK, HSB, nebo interaktivně ze schématu vlevo.  
○ Po vybraní vhodně barvy klikněte na OK. 
○ Náhled kolorizace vlevo se po chvíli aktualizuje.  
○ V miniatuře vpravo uvidíte umístěný pin s vybranou barvou.  
○ Tímto způsobem přidáte pin na zvolené místo a vyplníte související 

oblast vybranou barvou. 
○ Pokud vám přijde související oblast malá (či naopak velká) je možné 

upravit sílu každého ohniskového bodu.  

 

Editace pinů: 

● Vyberte pin pro úpravu barvy nebo 
přetáhněte pin na jiné místo. 

● Pokračujte v přidávání pinů a výběru 
barev podle potřeby. 

○ Pin má implicitně stejnou barvu, 
jako pin předchozí.  

● Pro změnu barvy již přidaného pinu 
klikněte dvakrát do barevného obdélníku 
Barva. 

● Pin lze odebrat kliknutím na konkrétní pin 
a následně na Odebrat.  

● Držte klávesu Alt a přetáhněte existující 
pin pro duplikování barvy na jiné místo v 
obrázku. 

● Je vždy lepší použít více pinů s nižší silou, než jednoho silného (viz příklady na 
konci postupu).  
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Plně manuální kolorizace: 

● Dle předchozího postupu je manuální uživatelský vstup brán jako dodatečný parametr 
automatické kolorizace. Algoritmus bude dál obarvovat zbytek obrázku.  

● Při odškrtnutí volby automatické kolorizace nebude zbytek obrázku kolorován vůbec: 

 

 

● Tento postup je vhodný jen v případě jednoduchých fotek, které obsahují jasně 
ohraničení objekty.  

● Na příkladu nahoře lze vidět kontrastní barvou obarvené objekty dlažby a auta.    

 

2. Přizpůsobení dalších parametrů (viz předchozí postup) 

Krok 5: Použití separátní vrstvy pro obarvení 

Pro drobné a další manuální úpravy je vhodné oddělit od sebe samotná data fotografie a 
informace o obarvení (přesný princip funkce viz samostatnou kapitolu Jak fungují vrstvy 
Barevnosti).  

1. Separátní výstup barvy 
○ V panelu kolorizace dole zaškrtněte možnost Výstup jako nová vrstva plné 

barvy. 

 

○ Náhled vlevo se změní, zůstanou jen zvolené barvy (což je patrné především 
při plně manuálním obarvení).  
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○ Při manuálním obarvením lze tak snadno nahlédnout, které části fotografie jsou 
už kolorovány a které ne (šedá barva). 

○ Takovou vrstvu lze zároveň snadno upravovat manuálně běžnými nástroji 
jako jsou Tužka, Guma, či Štětec, jakmile bude kolorizace dokončena.  

 

2. Dokončete kolorizaci 
3. Nastavení režimu vrstvy: 

○ Po dokončení kolorizace bude vytvořena nová, částečně průhledná vrstva 
složena jen z barvy.  

i. Výsledek, který je vidět v hlavním okně je nyní kombinace podkladové 
vrstvy (Pozadí) a částečně průhledné vrstvy nad ním (Vrstva 2).  

 

○ Můžete změnit režim nové vrstvy na „Color“ (barva) nebo „Overlay“ (překrýt) v 
rozbalovacím menu v horní části panelu Vrstvy. Tento režim zajistí, že barva 
promítne na podkladovou černobílou vrstvu bez ovlivnění detailů. Pro 
podrobnosti a přesný výpočet barvy viz kapitolu Jak fungují vrstvy 
Barevnosti. 

○ Manuálně upravujete tu vrstvu, které je vybraná (podbarvená), vyberte vrstvu 
s barevností.  
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4. Použití nástroje Brush Tool: 
○ Vyberte nástroj Brush Tool (B) a v panelu nástrojů vyberte barvu, kterou chcete 

použít. Použijte Color Picker pro přesné určení barvy. 
○ Můžete manuálně upravit libovolné části vrstvy.  
○ Pro snadnější použití můžete v menu Vrstvy skrýt (ikonka oka) podkladovou 

vrstvu. Uvidíte tak pouze barevnost.  
5. Malování na novou vrstvu: 

○ Malujte vybranou oblast pomocí štětce. Ujistěte se, že pracujete na nové 
vrstvě, aby úpravy byly nedestruktivní. 

6. Použití gumy a dalších nástrojů   
○ V případě nejasných hran lze tyto části obrázku upravit manuálně.  

Krok 6: Uložení a Export 

1. Uložení souboru ve formátu PSD: 
○ Doporučujeme uložit upravený soubor ve formátu PSD, abyste mohli případně 

provést další úpravy v budoucnu. Jděte na File > Save As a vyberte 
Photoshop (*.PSD, *.PDD). 

○ Soubor PSD ukládá i neviditelné vrstvy, proto je to vhodný postup pro uložení 
rozpracované práce, či práce ke které se budete chtít někdy vrátit.  

2. Export hotové fotografie: 
○ Pro sdílení nebo tisk můžete exportovat finální kolorizovaný obrázek do 

běžného formátu, jako je JPEG nebo PNG. 
○ Export vytváří jedinou finální vrstvu a tu uloží jako obrázek. Slouží tedy vrstvu 

barevnosti i podkladu.  
i. ujistěte se, že jste jednu z vrstev neskryli. 

○ Jděte na File > Export > Export As. 
○ Vyberte požadovaný formát (např. JPEG nebo PNG) a nastavte kvalitu a 

rozlišení podle potřeby. 
○ Klikněte na Export a vyberte umístění pro uložení souboru. 

5.5.2 Popis výpočtu finálního vzhledu z jednotlivých vrstev  

Neurální filtry v Adobe Photoshopu využívají pokročilé algoritmy strojového učení k 
automatické kolorizaci černobílých fotografií. Jedním z efektivních způsobů, jak toho 
dosáhnout, je použití dvou vrstev: jedna vrstva obsahuje původní černobílý podklad a druhá 
vrstva obsahuje pouze barvu. Tento proces kombinuje informace z obou vrstev pro dosažení 
realistického barevného výsledku. 

Režimy vrstev "Color" a "Overlay" jsou v Adobe Photoshopu často používány pro úpravy barev 
a tonální přizpůsobení. Každý z těchto režimů má specifické vlastnosti a poskytuje různé 
vizuální výsledky, které mohou být vhodné pro různé typy úprav. 

Režim Vrstvy "Color" 

Vizuální Vzhled 

● Režim "Color" kombinuje barevné informace (odstín a sytost) z aktuální vrstvy s 
jasovými informacemi z vrstev pod ní. 
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● Tento režim nezmění světlost nebo kontrast obrázku, ale pouze barvu. 

Příklady Použití 

1. Kolorizace černobílých fotografií: 
○ Režim "Color" je ideální pro přidávání barvy do černobílých fotografií, protože 

zajišťuje, že původní kontrast a detaily obrazu zůstanou nezměněny. 
2. Barevné korekce: 

○ Lze jej použít k opravě barevných tónů bez ovlivnění světlosti nebo kontrastu 
obrázku. Například změna barvy objektu nebo části obrazu. 

Výhody 

● Zachovává světlost a kontrast. 
● Vhodný pro precizní barevné úpravy a kolorizaci. 

Nevýhody 

● Nemění jas a kontrast, což může být nevýhodné, pokud chcete kombinovat barevné 
změny s úpravami jasu. 

Režim Vrstvy "Overlay" 

Vizuální Vzhled 

● Režim "Overlay" kombinuje režimy "Multiply" a "Screen". Zesvětluje světlé oblasti a 
ztmavuje tmavé oblasti, což zvyšuje kontrast a saturaci barev. 

● Tento režim zesiluje světlé oblasti a ztmavuje tmavé oblasti, což vede k výraznějšímu 
kontrastu a často i živějším barvám. 

Příklady Použití 

1. Zvýšení kontrastu a saturace: 
○ Režim "Overlay" je skvělý pro přidání dynamiky a kontrastu k obrázkům. Často 

se používá k oživení plochých nebo vybledlých obrázků. 
2. Efekty svícení a stínování: 

○ Používá se k vytváření dramatických efektů světla a stínu na obrázcích, což 
může být užitečné pro umělecké nebo dramatické úpravy. 

Výhody 

● Zvyšuje kontrast a saturaci, což může oživit ploché nebo vybledlé obrázky. 
● Vhodný pro dramatické efekty a zvýraznění detailů. 

Nevýhody 

● Může snadno přehánět kontrast a saturaci, což vede k příliš výrazným a nepřirozeným 
výsledkům. 

● Nevhodný pro jemné barevné úpravy, kde je důležité zachovat přirozený vzhled. 
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5.5.3 Princip kolorizace pomocí dvou vrstev 

Podkladová vrstva: 

● Obsahuje původní (černobílý) obrázek. Tato vrstva zajišťuje detailní textury, kontrast 
a jas fotografie. 

Barevná vrstva: 

● Obsahuje informace o barvách generovaných neurálním filtrem. Tato vrstva je obvykle 
aplikována v režimu „Color“ nebo „Overlay“, aby se barvy promítly na podkladovou 
vrstvu bez ovlivnění detailů. 

Matematický Model Kolorizace 

Kolorizaci lze popsat matematicky pomocí maticové reprezentace obrázků. Předpokládejme, 
že máme černobílý obrázek IBWI  a barevnou vrstvu IColor  

1. Podkladová vrstva IBWI 
○ Tento obrázek je reprezentován jako matice intenzit světla IBW={iij}, kde iij je 

intenzita pixelu na pozici (i,j)  
2. Barevná vrstva IColor  

○ Barevná vrstva je reprezentována jako matice barev IColor={cij}, kde cij je vektor 
obsahující barevné složky (např. RGB) na pozici (i,j). 

Výsledný obrázek IResult je kombinací těchto dvou vrstev: 

 

kde f je funkce kombinující intenzitu černobílého obrázku s barevnými informacemi. 

Režim „Color“ 

Při použití režimu „Color“ se barva z vrstvy IColor promítne na intenzitu z vrstvy IBW: 

 

kde max(IBW) je maximální hodnota intenzity v černobílém obrázku, což normalizuje intenzitu 
pro správnou aplikaci barvy. 

Režim „Overlay“ 

V režimu „Overlay“ je barva aplikována podle specifického vzorce, který kombinuje režimy 
„Multiply“ a „Screen“ v závislosti na intenzitě podkladového pixelu: 
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Kolorizace pomocí dvou vrstev – podkladové černobílé a barevné vrstvy – v Adobe 
Photoshopu využívá pokročilé algoritmy strojového učení k dosažení realistických výsledků. 
Kombinace těchto vrstev pomocí různých režimů, jako je „Color“ a „Overlay“, umožňuje 
zachovat detaily a textury původního obrázku, zatímco se přidávají barvy. Tento proces 
poskytuje flexibilitu a kontrolu, které jsou nezbytné pro profesionální kolorizaci a restauraci 
historických fotografií. 

Implicitní způsob překryvu je režim “Barva,” který funguje velmi jednoduše, ale u oblastí s 
velkou tmavostí je vliv barvy vizuálně nižší. 

Kdy Použít "Color" a Kdy "Overlay" 

Použití "Color" 

● Kolorizace černobílých fotografií: Když chcete přidat barvy, aniž byste změnili 
původní světlost a kontrast. 

● Barevné korekce: Když potřebujete opravit nebo změnit barvu objektů, aniž byste 
ovlivnili tonální rozsah obrázku. 

● Přizpůsobení tónů: Pro jemné doladění barevných tónů bez ovlivnění jasu a 
kontrastu. 

Použití "Overlay" 

● Zvýšení kontrastu a saturace: Když chcete zvýšit dynamiku obrázku a dodat mu 
živější vzhled. 

● Efekty svícení a stínování: Když chcete vytvořit dramatické efekty světla a stínu, 
které zdůrazňují hloubku a texturu. 

● Oživení vybledlých obrázků: Když potřebujete dodat plochým nebo vybledlým 
obrázkům nový život. 
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5.6 Příklady kolorizace 

 

Příklad 1, Demonstrace vlivu ohniskových bodů, vybrána červená barva dle historické, 
původní barevné fotografie: Vlevo nahoře originální fotografie, vpravo nahoře ohniskové 

body, vlevo dole: výsledná kolorizace. Vpravo dole: historická, barevná fotografie.  
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Příklad 2, porovnání nastavení hodnoty “Redukce šumu”, vlevo: 80, vpravo: 5 

 

 

Příklad 3, detail kolorované fotografie (vlevo) a zdrojová fotka (vpravo) 
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5.6.1 Typické chyby 

Kolorizace černobílých fotografií pomocí neurálních filtrů ve Photoshopu představuje pokročilý 
nástroj, který dokáže automaticky přidávat barvy na základě analýzy obrazu a tréninkových 
dat. Tento proces může být velmi efektivní a rychlý, ale často se vyskytují situace, kdy model 
chybně interpretuje určité části obrazu. Typickým příkladem je přemíra zelené barvy na 
velkých rovných plochách, které jsou nesprávně identifikovány jako tráva nebo vegetace. 
Tento jev je důsledkem toho, že modely jsou často trénovány na hezkých fotografiích, kde 
jsou zelené plochy běžné. V tomto kontextu se manuální doladění a nastavení ohniskových 
bodů stává nezbytným krokem k dosažení realistických a přesných výsledků. 

5.6.2 Automatická Kolorizace a Její Limity 

Automatická kolorizace využívá neurální sítě, které analyzují obrazové rysy a aplikují barvy 
na základě předchozího tréninku na rozsáhlých databázích barevných fotografií. Tento přístup 
je velmi užitečný pro rychlou kolorizaci a často poskytuje překvapivě dobré výsledky. Nicméně 
modely mohou mít tendenci přidávat barvy, které odpovídají častým vzorcům ve tréninkových 
datech, což vede k problémům v určitých scénářích. 

Jedním z hlavních problémů je přemíra zelené barvy na velkých rovných plochách, jako jsou 
silnice nebo betonové plochy, které jsou chybně interpretovány jako tráva. Tento problém 
vyžaduje manuální zásah, aby se zajistilo, že barvy odpovídají skutečnosti. 

5.6.3 Manuální Nastavení Ohniskových Bodů 

Pro opravu těchto chyb je nutné použít manuální nastavení ohniskových bodů. Tento proces 
zahrnuje použití nástroje Color Picker a přidávání pinů na specifické oblasti obrázku, kde 
chcete změnit automaticky vybranou barvu. 

Například pokud je velká rovná plocha chybně zbarvena zeleně, můžete použít Color Picker 
k výběru správné barvy, jako je šedá pro asfaltovou silnici. Poté kliknete na náhled obrázku 
na místě, kde chcete změnit barvu, čímž přidáte pin. Tento pin přinutí filtr znovu zbarvit oblast 
kolem něj pomocí nové vybrané barvy. Tento proces můžete opakovat pro všechny 
problematické oblasti, přidávat další piny a nastavovat správné barvy, dokud nebude celá 
fotografie správně kolorizována. 
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Příklad 4: Příklad chybné automatické kolorizace (dlažba, pravděpodobně jeden z autobusů) 

 

 

Příklad 5: Příklad chybné automatické kolorizace (cedule) 
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V první příkladě lze kolorizaci manuálně vylepši přidáním šedomodrého pinu na 
plochu dlažby. V druhém příkladě vidíme zjevně chybně obarvenou ceduli “ZBOŽÍ.” 
Zatímco v prvním příkladě je třeba barvy dlažby odhadnout (či použít barvy 
obdobná dlažby), v druhém případě můžeme využít iterativního obarvení - nejdříve 
použít automatické obarvení, akceptovat jej a pomocí nástroje kapátko z něj vybrat 
vhodné barvy k vytvoření ohniskových bodů a vytvoření finální kolorizace opětovnou aplikací 
filtru na zdrojovou vrstvu.   

 

Ilustrace výběru barvy, na vnitřním kruhu lze vidět vybranou barvu.  
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Příklad 6: Vlevo: Originální fotografie, Uprostřed: Ohniskové body, Vpravo: Výsledná finální 
kolorizace  
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5.7 Ukázky kolorizace a vylepšení kvality fotek 

 
Příklad 7: Velmi poškozená kolorovaná fotografie.  
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Příklad 8: Opakování postupu odstranění škrábanců => kolorizace => odstranění škrábanců 

pro velmi poškozenou fotku 
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Příklad 9: Silně poškozená fotka, automatické odstranění škrábanců, automatická kolorizace 
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6. Volně dostupné pokročilé automatické nástroje 
pro restaurování fotografií 
Restaurování fotografií pomocí metod počítačové grafiky je po mnoho let zkoumaná oblast. 
Kromě běžných algoritmů se spolu s rostoucím výkonem počítačů do popředí dostává 
automatické zpracování pomocí neuronových sítí a algoritmů umělé inteligence. Těchto 
algoritmů lze v literatuře najít celkem velký počet. Jedním z nich je následující metoda 
Bringing-Old-Photos-Back-to-Life. 

6.1 Vylepšení fotek pomocí naučené neuronové sítě Bringing-
Old-Photos-Back-to-Life 

Tento software vytvořený během několikaletého výzkumu týmem vědců z Hong-Kongské 
univerzity lze získat zde: https://github.com/microsoft/Bringing-Old-Photos-Back-to-Life. 

Software pracuje na principu využití naučené neuronové sítě, která v několika krocích detekuje 
poškození fotek, opravuje jej a následně pomocí další neuronové sítě vylepší celkový vzhled 
fotky. 

6.1.1. Lokální instalace 

Instalaci je třeba provést na linuxové distribuci (doporučeno Ubuntu) nebo případně na 
Windows s nainstalovaným Ubuntu ve WSL. Je třeba mít grafickou kartu NVidia s podporou 
CUDA a alespoň 8 GB grafické paměti. 

 

V linuxovém terminálu je třeba provést následující kroky: 

1. Nainstalovat Python3 (minimálně ve verzi 3.6), cmake a git. 
2. Naklonovat repozitář s projektem příkazem: 

git clone https://github.com/microsoft/Bringing-Old-Photos-Back-to-Life 
a následně do této složky přejít. 

3. Následně je třeba stáhnout naučené modely pomocí příkazů: 
cd Face_Enhancement/models/networks/ 
git clone https://github.com/vacancy/Synchronized-BatchNorm-PyTorch 
cp -rf Synchronized-BatchNorm-PyTorch/sync_batchnorm . 
cd ../../../ 

 
cd Global/detection_models 
git clone https://github.com/vacancy/Synchronized-BatchNorm-PyTorch 
cp -rf Synchronized-BatchNorm-PyTorch/sync_batchnorm . 
cd ../../ 

4. Volitelně je možné stáhnout data pro detekci tváří, ale vzhledem k tématu projektu to 
není třeba. 

https://github.com/microsoft/Bringing-Old-Photos-Back-to-Life
https://github.com/microsoft/Bringing-Old-Photos-Back-to-Life
https://github.com/vacancy/Synchronized-BatchNorm-PyTorch
https://github.com/vacancy/Synchronized-BatchNorm-PyTorch
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cd Face_Detection/ 
wget http://dlib.net/files/shape_predictor_68_face_landmarks.dat.bz2 
bzip2 -d shape_predictor_68_face_landmarks.dat.bz2 
cd ../ 

5. Nainstalovat potřebné balíčky pro Python3: 
pip install -r requirements.txt 

6. Dále je třeba udělat skript na spouštění dávkové konverze. Do souboru s názvem 
restore  umístěného ve složce z Githubu vložíme následující řádky: 

cd Global/ 

python test.py --Quality_restore \ 

               --test_input  ../../data-img \ 

               --outputs_dir ../../output2 \ 

               --test_mode Full \ 

               --HR 

7. A do souboru scratch_restore vložíme: 
cd Global/ 

python detection.py --test_path ../../data-img \ 

                    --output_dir ../../output \ 

                    --input_size full_size 

 

python test.py --Scratch_and_Quality_restore \ 

               --test_input  ../../output/input \ 

               --test_mask ../../output/mask \ 

               --outputs_dir ../../output2 \ 

               --HR 

8. Dále je třeba vytvořit složku se zdrojovými fotkami. Tu vytvoříme na stejné úrovni, jako 
se složka se samotným projektem z Githubu, a pojmenujeme data-img 

9. Tím je instalace dokončena. 

6.1.2. Poznámky 

Zpracování fotek na GPU pomocí NVidia Cuda spotřebovává mnoho grafické paměti a nelze 
tedy zpracovat fotky v originálním naskenovaném rozlišení. Na stroji s 8 GB GPU paměti je 
třeba fotky zmenšit alespoň na 50 % původní velikosti (při větším poškození fotky i na zhruba 
33 % původní velikosti). 
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6.1.3 Výsledky úprav (verze bez odstranění poškození) 

Na fotky byl aplikován plně automatizovaný proces vylepšení kvality fotek pomocí postupu v 
kapitole 4.4 Postup A4: Plně automatické rekonstrukce v Bringing-Old-Photos-Back-to-Life. 
Na levé straně je původní obrázek, na pravé je upravený. 
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Zhodnocení úprav 

Tyto úpravy zlepšují kontrast fotek a doplňují některé ztracené detaily. Z ukázek je vidět, že 
fotky jsou většinou hezčí na pohled. Bohužel natrénovaný model není příliš vhodný na fotky, 
kde se nachází drobnější písmo, které není dobře zpracování a stává se nečitelným (například 
poslední dvojice obrázků, texty na tabuli).  
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6.1.4 Výsledky úprav (verze s odstraněním škrábanců) 
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Zhodnocení úprav 

K dispozici nebyly fotky, které by byly výrazně poškozené, proto jsme provedli testování na 
uměle vložených škrábancích. Z výsledků je vidět, že menší poškození byla odstraněna 
celkem dobře, ale u větších dochází k velkému rozmazání vnitřku i okolí škrábance. Tyto 
úpravy jsou tedy spíše vhodné pro fotky s menším rozlišením nebo pro fotky s méně detaily. 

6.1.5 Závěr 

Tento open-source software založený na strojovém učení je vhodný spíše pro doladění kvality 
a kontrastu fotek. Odstranění poškození škrábanci a podobně dává spíše horší výsledky. 
Výhodou je dávkové zpracování velkého množství fotek. 
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7. Použití ručně kolorovaných fotografií a maleb 
jako referencí pro kolorizaci 
Při kolorizaci historických černobílých fotografií může automatická kolorizace pomocí nástrojů, 
jako je Adobe Photoshop, někdy selhat, zejména pokud jde o přesné zachycení barevných 
odstínů, které byly původně přítomny. V těchto případech může být užitečné využít jako 
referenci ručně kolorované fotografie nebo malby, které poskytují vizuální vodítko pro barvy a 
jejich distribuci v konkrétním historickém období. Tento přístup má své výhody, ale také 
nevýhody, které je třeba pečlivě zvážit. 

7.1 Úvod 

Pozitiva použití ručně kolorovaných fotografií a maleb 

● Historická věrohodnost: Ručně kolorované fotografie a malby často vznikaly v době, 
kdy byly vytvořeny původní černobílé snímky, a proto mohou poskytovat cenný vhled 
do autentických barevných schémat té doby. Malíři a koloristé, kteří tyto obrazy 
vytvářeli, mohli mít přímý přístup k tehdejším objektům a scénám, což zvyšuje 
pravděpodobnost, že použité barvy jsou věrné skutečnosti. 

● Estetická hodnota: Ručně kolorované obrazy a fotografie mají obvykle vyšší 
estetickou hodnotu, protože byly vytvořeny s ohledem na vizuální harmonii a umělecký 
dojem. Při použití těchto děl jako referencí může být výsledná kolorizace přirozenější 
a vizuálně přitažlivější. 

● Detailní barevné informace: Ručně kolorované fotografie a malby mohou nabídnout 
detailní informace o barvách, které jsou jinak obtížně rekonstruovatelné. Například 
barva oděvů, vegetace nebo architektonických prvků může být přesněji zachycena, 
což přispívá k větší autentičnosti výsledné kolorizace. 

● Doplňkový zdroj: Tyto obrazy mohou sloužit jako doplňkový zdroj pro automatické 
kolorizace, které se mohou mýlit v tonálních hodnotách nebo přiřazení konkrétních 
barev k objektům. Kombinace automatických technik s manuálními referencemi může 
vést k přesnějším výsledkům. 

Negativa použití ručně kolorovaných fotografií a maleb 

● Subjektivní interpretace barev: Ručně kolorované fotografie a malby mohou být 
výsledkem subjektivní interpretace umělce. Koloristé a malíři mohli používat barvy 
podle vlastního uvážení nebo vkusu, což znamená, že výsledné obrazy nemusí vždy 
přesně odpovídat skutečným barvám. Tato subjektivita může vést k nesprávné 
kolorizaci historických fotografií. 

● Technická omezení: Ručně kolorované fotografie a malby mohou být technicky 
omezené, pokud jde o přesnost barev. Omezené palety, techniky aplikace barev a 
degradace materiálů v průběhu času mohou zkreslit původní vzhled, což může vést k 
chybným závěrům při použití těchto děl jako referencí. 

● Nesoulad s fotografickými detaily: Ručně kolorované fotografie a malby nemusí 
vždy věrně zachycovat jemné detaily a textury, které jsou přítomny na černobílých 
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fotografiích. Při pokusu o integraci těchto děl s moderními digitálními technologiemi 
může dojít k nesouladu, který ovlivní celkovou kvalitu a konzistenci kolorizace. 

● Riziko stylizace: Malby a ručně kolorované fotografie mohou být stylizovány a 
přizpůsobeny uměleckým záměrům spíše než věrnému zachycení reality. Pokud jsou 
použity jako reference, mohou přenést tuto stylizaci do výsledné kolorizace, což může 
být nevhodné pro vědecké nebo dokumentární účely. Nicméně, pokud je k dispozici 
tabulka reálných vzhledů materiálů, stylizovaná fotografie může být použita jako 
vodítko pro identifikaci materiálu. Následně je možné vybrat odpovídající materiál z 
této tabulky a použít jej pro přesnější kolorizaci, což zajistí vyšší věrohodnost 
výsledného obrazu. 

7.2 Doporučený postup 

1. Příprava černobílé fotografie: 
○ Skenujte černobílou fotografii ve vysokém rozlišení do formátu TIFF nebo PNG, 

aby byla zajištěna co nejlepší kvalita obrazu pro následnou kolorizaci. 
2. Shromáždění referencí: 

○ Najděte a shromážděte ručně kolorované fotografie nebo barevné malby, které 
zachycují podobné objekty, scény nebo období, jako je fotografie, kterou 
chcete kolorovat. 

3. Porovnání a analýza: 
○ Analyzujte kolorované fotografie a malby a určete, jaké barvy byly použity pro 

různé objekty a materiály (např. cihly, omítky, vegetace, oděvy). 
○ Zkontrolujte, zda jsou barvy na referenčních snímcích v souladu s tabulkami 

reálných materiálů. Pokud jsou stylizované, použijte referenční snímky pouze 
jako vodítko pro výběr správného materiálu z tabulky. 

4. Aplikace barev: 
○ Pomocí softwaru jako Adobe Photoshop začněte s kolorizací černobílé 

fotografie. Můžete využít automatické nástroje pro kolorizaci a následně ručně 
doladit barvy podle referencí. 

○ Použijte barvy identifikované z kolorovaných fotografií a maleb pro různé části 
snímku, přičemž dbejte na věrnost a autenticitu barev. 

○ Pokud automatická kolorizace není dostatečná, aplikujte barvy ručně pomocí 
nástrojů pro výběr a vyplnění. 

5. Retušování: 
○ Pokud je fotografie poškozená, proveďte základní retušování pomocí nástrojů 

pro odstranění škrábanců, prachu a dalších vad. 
6. Kontrola a finalizace: 

○ Porovnejte výsledný barevný obraz s původními referencemi a tabulkami 
materiálů, abyste zajistili, že barvy odpovídají historické skutečnosti. 

○ Proveďte potřebné finální úpravy, včetně doladění sytosti, kontrastu a dalších 
parametrů, aby byl výsledný obraz esteticky příjemný a historicky věrohodný. 

7. Uložení a archivace: 
○ Uložte finální kolorovaný obraz v bezztrátovém formátu (např. PNG), abyste 

zachovali maximální kvalitu. 
○ Archivujte původní černobílý sken spolu s kolorovanou verzí a referenčními 

materiály pro budoucí použití a dokumentaci. 
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Závěr 

Použití ručně kolorovaných fotografií a maleb jako referencí pro kolorizaci historických 
černobílých fotografií může být cenným nástrojem pro dosažení věrohodných a esteticky 
příjemných výsledků. Nicméně je třeba pečlivě zvážit jejich subjektivní povahu a technická 
omezení, aby se předešlo chybám a zkreslení v historické rekonstrukci. Kombinace těchto 
manuálních referenčních zdrojů s moderními digitálními technikami, včetně použití tabulek 
reálných vzhledů materiálů, umožní dosáhnout co nejpřesnějších a nejvěrnějších výsledků, 
které budou užitečné pro historický výzkum a dokumentaci. 

7.3 Barevné kódy nejčastějších materiálů   

Pro určování arbitrárních hodnot stavebních materiálů je vhodné znát ideální barvy a odstíny 
různých materiálů. Mnoho barevných odstínů (např. hnědá barva dřeva) a jejich nastavení 
nemusí být v rozhraní různých typech softwaru intuitivní. Pro nejčastější, či problematické 
materiály byly proto vytvořeny následující návodné tabulky barevných hodnot.  

Tato tabulky obsahují různé RGB a CMYK nastavení pro stavební materiály a může sloužit 
jako zdroj barevných informací pro vytváření ohniskových bodů dle postupu B2.   

7.3.1 Tabulka barev pro stavební materiály 

Pro vytvoření podobné tabulky pro stavební materiály jako jsou cihly, kámen, dlažba, a střecha 
z pálených tašek, se zaměříme na odstíny, které jsou běžně používány v architektuře. 
Budeme zahrnovat různé barevné variace pro každý materiál, které mohou odrážet různé tóny 
světlosti v závislosti na osvětlení.   

Stavební materiály a jejich barvy 

Materiál Světlý Tón Střední Tón Tmavý Tón 

Cihly RGB: 205, 92, 92   
CMYK: 0, 55, 55, 20 

RGB: 178, 34, 34   
CMYK: 0, 81, 81, 30 

RGB: 139, 0, 0   
CMYK: 0, 100, 100, 45 

Kámen RGB: 169, 169, 169   
CMYK: 0, 0, 0, 34 

RGB: 105, 105, 105   
CMYK: 0, 0, 0, 59 

RGB: 47, 79, 79   
CMYK: 40, 0, 0, 69 

Dlažba RGB: 233, 150, 122   
CMYK: 0, 36, 48, 9 

RGB: 210, 105, 30   
CMYK: 0, 50, 86, 18 

RGB: 139, 69, 19   
CMYK: 0, 50, 86, 45 
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Střecha 
(Pálené 
tašky) 

RGB: 244, 164, 96   
CMYK: 0, 33, 61, 4 

RGB: 210, 105, 30   
CMYK: 0, 50, 86, 18 

RGB: 165, 42, 42   
CMYK: 0, 74, 74, 35 

Beton RGB: 190, 190, 190   
CMYK: 0, 0, 0, 25 

RGB: 128, 128, 128   
CMYK: 0, 0, 0, 50 

RGB: 85, 85, 85   
CMYK: 0, 0, 0, 67 

7.3.2 Příklady a významy barev 

1. Cihly: 
○ Světlý Tón (RGB: 205, 92, 92; CMYK: 0, 55, 55, 20): Používá se často pro 

moderní, světlé fasády. 
○ Střední Tón (RGB: 178, 34, 34; CMYK: 0, 81, 81, 30): Typický pro tradiční 

stavby s červenými cihlami. 
○ Tmavý Tón (RGB: 139, 0, 0; CMYK: 0, 100, 100, 45): Vhodný pro historické 

nebo rustikální budovy. 
2. Kámen: 

○ Světlý Tón (RGB: 169, 169, 169; CMYK: 0, 0, 0, 34): Světlý kámen pro 
moderní designy. 

○ Střední Tón (RGB: 105, 105, 105; CMYK: 0, 0, 0, 59): Tradiční šedý kámen 
pro většinu staveb. 

○ Tmavý Tón (RGB: 47, 79, 79; CMYK: 40, 0, 0, 69): Tmavý kámen pro 
historické nebo elegantní stavby. 

3. Dlažba: 
○ Světlý Tón (RGB: 233, 150, 122; CMYK: 0, 36, 48, 9): Světlá dlažba pro 

moderní exteriéry. 
○ Střední Tón (RGB: 210, 105, 30; CMYK: 0, 50, 86, 18): Typická hnědá dlažba 

pro tradiční chodníky a terasy. 
○ Tmavý Tón (RGB: 139, 69, 19; CMYK: 0, 50, 86, 45): Tmavá dlažba pro 

rustikální a elegantní vzhled. 
4. Střecha (Pálené tašky): 

○ Světlý Tón (RGB: 244, 164, 96; CMYK: 0, 33, 61, 4): Světlé pálené tašky pro 
moderní domy. 

○ Střední Tón (RGB: 210, 105, 30; CMYK: 0, 50, 86, 18): Tradiční barva pro 
většinu střech. 

○ Tmavý Tón (RGB: 165, 42, 42; CMYK: 0, 74, 74, 35): Tmavé pálené tašky pro 
historické nebo rustikální stavby. 

5. Beton: 
○ Světlý Tón (RGB: 190, 190, 190; CMYK: 0, 0, 0, 25): Světlý beton pro 

moderní, světlé stavby. 
○ Střední Tón (RGB: 128, 128, 128; CMYK: 0, 0, 0, 50): Typický šedý beton pro 

většinu konstrukcí. 
○ Tmavý Tón (RGB: 85, 85, 85; CMYK: 0, 0, 0, 67): Tmavý beton pro moderní, 

minimalistické stavby. 
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 Část A: Kolorizace a retuš fotek Mírového náměstí 

 

Radek Richtr 

 

1. Úvod  

V oblasti restaurování starých fotografií dochází k výrazným pokrokům díky novým 
technologiím, které kombinují pokročilé algoritmy, umělou inteligenci (AI) a strojové učení 
(ML). Cílem této zprávy je ověřit účinnost a spolehlivost těchto technologií, které umožňují 
zaostření, kolorizaci a odstranění nepřesností a škrábanců z historických fotografií. V rámci 
ověření technologie jsme použili navržené nástroje a metody a analyzovali jejich výkon a 
výsledky. 

2. Specifikace dat 

Data použitá v tomto projektu pocházejí z historických fotografií města Most. Tyto fotografie 
jsou cennými vizuálními dokumenty, které zachycují město před jeho zbořením v 60. a 70. 
letech 20. století. Most, historické město s bohatou kulturní a architektonickou tradicí, bylo z 
velké části zničeno kvůli těžbě uhlí. Fotografie z této doby poskytují unikátní pohled na město, 
jeho infrastrukturu, architekturu a každodenní život obyvatel. 

Pro tuto zprávu byly využity anotované fotografie Mírového náměstí vyfocené v průběhu 
července 1975. 
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Obr 1. Ukázka zdrojových dat 
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3. Popis dat 

U zdrojových dat se jedná o sken fyzických černobílých v digitálním formátu (TIFF) ve 
vysokém rozlišení. Fotografie jsou doplněny o anotované informace. Sken v bitové hloubce 
24b, rozlišení 4986 x 6914. 

Stav fotografií  

Viditelné škrábance, známky degradace materiálu, blednutí barev, ztráta kontrastu, 
rozmazání způsobené  technologickými omezeními fotoaparátů dané doby.  

Použitý hardware 

Pro veškeré úpravy fotek s vysokým rozlišením je používán hardware Lenovo Legion Pro 7, 
který poskytuje dostatečný výpočetní výkon pro zpracování a restaurování historických 
fotografií (Procesor: Intel Core i9, Grafická karta: NVIDIA GeForce RTX 4090, RAM 32GB)  

4. Postup retušování 

Pro retušování byl vybrán postup s nejkvalitnějšími výsledky, tedy manuální a polomanuální 
postup v sw Photoshop s využitím AI a neuronových filtrů. Pro fotografie byl zvolen postup 
kolorizace A2.  

Kolorizace 

Před kolorizací byl zdrojový sken ořezán tak, aby se kolorovala pouze část skenu s danou 
fotografií. Automatický sken s Neurálním filtrem a AI poskytl dostatečně kvalitní výsledek. Ve 
shodě s doporučeným nastavením byly nastaveny parametry kolorizace shodně sytost +23 a 
redukce šumu +5, purpurová/zelená -15 a žlutá/modrá -15.  
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Obr 2. Výsledky kolorizace 
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Obr 3. Výsledky kolorizace 

Retuš 

U fotek, kde je to potřeba byla provedena drobná manuální retuš postupem A1 odstraňující 
nežádoucí artefakty a škrábance. Nejprve byly automaticky detekovány a odstraněny 
škrábance a drobné defekty na fotkách postupem A1 a až v případě nutnosti (viz níže) byl 
aplikován následně postup A3 pro vyplnění velmi poškozených a nežádoucích oblastí 
algoritmem generative content fill.   

Obtíže 

V případě některých systematických poškození (Obr 3.) není automatický filtr odstranění 
poškození dostatečný ani s ideálním nastavením - ve výsledných fotografiích je původní 
poškození stále patrné (Obr. 3, uprostřed). Pro jeho odstranění bylo zapotřebí oblast vybrat 
manuálně a nahradit ji generovaným obsahem (Obr 3, vpravo). Detail poškozené oblasti je 
vidět znovu na Obr 4. 

   
 
Časová dotace 

Jak pro kolorizaci, tak pro retušování fotek byl čas strávený úpravou v rozsahu jedné až tří 
minut.    
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Obr 3. Problematické části retuše (vlevo fotografie po kolorizaci, uprostřed automatická 
retuš, vpravo manuální) 

 

Obr 4. Detail poškozené části z Obr. 3 (nahoře: poškozený originál, uprostřed: automatická 
oprava, dole: manuální retuš) 

5. Dílčí závěr 

Nastavení automatické kolorizace fotografií města Most bylo provedeno s navrženými 
parametry dle navržené technologie výše. Automatický retušovací proces byl aplikován k 
odstranění viditelných škrábanců a prachu, jež je pro staré fotografie typické. Nicméně, jak 
ukázaly výsledky, automatická retuš je v některých případech nedostatečná a není schopna 
zcela odstranit všechny nedokonalosti. 

V takových krajních případech je nezbytné provést finální manuální úpravy, které zajistí 
maximální kvalitu a věrnost obnoveného obrazu. Tyto manuální úpravy byly provedeny i zde 
tak, aby bylo dosaženo co nejlepších výsledků, jak je demonstrováno na Obr. 4. Výsledky 
ukazují, že kombinace automatických a manuálních technik poskytuje vysoce kvalitní obnovu 
historických fotografií, která je důležitá pro jejich další využití v historických studiích a 
digitálních archivech. 
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Část B: Retuš fotek Mírového náměstí se zaměřením na 
odstranění nežádoucích objektů v kompozici fotografie 

Radek Richtr 

1. Úvod 

V oblasti restaurování starých fotografií města Most se setkáváme nejen s technickými 
problémy jako jsou škrábance, prach a degradace materiálu, ale také s kompozičními 
výzvami. Tyto fotografie často obsahují objekty, jako jsou auta, značky, a lidé, které zakrývají 
klíčové architektonické prvky budov. Cílem této zprávy je ověřit úspěšnost navrženého 
technologického postupu A3 k odstranění těchto překážek a obnovení čistých pohledů na 
fasády budov, které jsou nezbytné pro jejich další rekonstrukci. 

2. Specifikace dat 

Fotografie použité v tomto projektu pocházejí z historických záznamů města Most, 
zachycujících město před jeho zbořením v 60. a 70. letech 20. století. Tyto fotografie jsou 
cennými vizuálními dokumenty, které poskytují unikátní pohled na městskou architekturu a 
infrastrukturu. Pro zprávu byly použity fotografie z Mírového náměstí.  

3. Stav fotografií 

Historické fotografie byly skenovány ve vysokém rozlišení do digitálního formátu TIFF. Tyto 
skeny zahrnují: 

● Černobílé fotografie: Přesněji se jedná o barevné skeny černobílých fotografií 
doplněných o ručně psaná metadata. 

● Rozlišení: 4986 x 6914 pixelů, bitová hloubka 24b. 
● Fyzické poškození: Viditelné škrábance, trhliny, prach a rozmazání způsobené 

technologickými omezeními doby. 
● Kompoziční problémy: Přítomnost aut, značek, lidí a dalších objektů, které zakrývají 

architektonické prvky budov. 

4. Použitý hardware 

Pro veškeré úpravy fotek s vysokým rozlišením byl použit notebook Lenovo Legion Pro 7, 
který poskytuje dostatečný výpočetní výkon pro zpracování a restaurování historických 
fotografií. Technické specifikace zahrnují: 

● Procesor: Intel Core i9 
● Grafická karta: NVIDIA GeForce RTX 4090 
● RAM: 32GB 
● Úložiště: 1TB SSD 

5. Postup retušování a odstranění překážek 

Pro odstranění nechtěných objektů z fotografií byly použity kombinované metody zahrnující 
automatizované nástroje a manuální úpravy. 
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Automatizované metody 

● Detekce a odstranění škrábanců a drobných objektů: Pomocí algoritmů pro detekci 
objektů byly identifikovány a odstraněny nežádoucí prvky, jako jsou auta a značky. 
Tyto algoritmy využívají konvoluční neurální sítě (CNN) pro efektivní rozpoznání a 
odstranění překážek. 

● Inpainting: Po provedení automatických oprav drobných vad byly fotografie 
dokončeny pomocí poloautomatické retuše algoritmem generative content fill, který 
využívá vzory okolní oblasti k doplnění chybějících částí obrazu. 

Manuální úpravy 

● Ruční retuš: V případech, kde automatizované metody nebyly dostatečné, byly 
provedeny ruční úpravy pomocí nástrojů v Adobe Photoshopu. Tento proces zahrnoval 
pečlivou rekonstrukci zakrytých architektonických prvků a odstranění nežádoucích 
objektů. 

6. Výsledky 

Výsledky kombinace automatizovaných a manuálních metod ukazují významné zlepšení v 
odstranění kompozičních problémů a obnově čistých pohledů na fasády budov. Obrázky před 
a po úpravě demonstrují efektivitu těchto technik. 

U objektů je třeba pečlivě volit jejich pořadí ve směru odpředu-dozadu, tedy od fotoaparátu až 
k fasádě cílové budovy.  

 

Obr.1: Vizualizace retuše domu č.p. 48; vlevo originál, uprostřed kolorizace, vpravo 
fotografie s odstraněnými objekty (auty). 
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Obr. 2: Původní sken černobílé fotografie (výřez skenu obsahující jen relevantní obrazová 
data) domu č.p. 1. 

 

Obr. 3: Původní, již kolorovaná fotografie s překážkami. 
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Obr. 4: Fotografie s 11 vyznačenými oblastmi obsahujícími objekty k odstranění 

 

Obr. 5: Postupné odstranění objektů pomocí výběru oblasti a vyplnění generativním 
obsahem, první 4 kroky. 
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Obr. 6: Postupné odstranění objektů pomocí výběru oblasti a vyplnění generativním 
obsahem, posledních 6 kroků. 
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Obr. 6: Finální retuš fotografie. 
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Obr. 7: Vizualizace postupu retuše u fotografie domu č.p. 45. od zdrojové fotografie (vlevo 
nahoře), její kolorizaci, odstranění objektů až k finální rekonstrukci (vpravo dole) 
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Obr. 8: Dům č.p. 9; vlevo nahoře původní sken fotografie, následně kolorizace a postupná 
retuš objektů. Vpravo dole: finální retuš fotografie.  

 

7. Dílčí závěr 

Nastavení automatické detekce a odstranění překážek bylo provedeno s navrženými 
parametry dle technologie využívající konvoluční neurální sítě a inpainting. Pro odstranění 
nežádoucích objektů bylo zapotřebí volit postup pro manuální retuši A3 s cílem k dosažení 
maximální kvality a věrnosti obnoveného obrazu.  

Výsledky ukazují, že kombinace automatických a manuálních technik poskytuje vysoce 
kvalitní obnovu historických fotografií, která je důležitá pro jejich další využití v historických 
studiích a digitálních archivech. Technologie a metodologie popsané v této zprávě se ukázaly 
jako efektivní a spolehlivé nástroje pro restaurování fotografií s problematickou kompozicí.  

Stále je však třeba brát v potaz, že postup A3 může vést ke ztrátě autenticity fotografie. 
Historické fotografie jsou často ceněny pro svou věrnost a schopnost zachytit skutečný obraz 
minulosti. Vytváření nových, neexistujících dat může narušit tuto autenticitu, což je obzvláště 
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problematické, pokud jsou tyto fotografie používány pro vědecké, historické nebo vzdělávací 
účely. Generativní algoritmy mohou vytvářet vizuálně přesvědčivé, ale nepřesné detaily, které 
mohou být nesprávně interpretovány jako skutečné historické záznamy. Toto je třeba brát v 
potaz při použití těchto postupů.  
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Část C: Retuš a kolorizace interiérových fotografií 

Radek Richtr 

1. Úvod 

Restaurování interiérových fotografií přináší specifické výzvy, které se liší od těch, které se 
týkají exteriérových snímků. Přestože se projekt specializuje na fotografie budov a 
architektonických prvků, může být vhodné v některých příkladech využít i fotky interiéru 
například pro vytvoření dokonalejšího modelu u velmi důležitých budov. Interiérové fotografie 
často trpí špatným osvětlením, viditelným opotřebením a poškozením v důsledku času. Tato 
zpráva se zaměřuje na proces retuše a kolorizace historických interiérových fotografií, 
popisuje použité technologie a postupy a analyzuje dosažené výsledky. 

2. Specifikace dat 

Fotografie použité v tomto projektu pocházejí z historických interiérů budov v městě Most, 
které byly zachyceny před jeho zbořením. Konkrétně se jedná o fotografie slavnostní (obřadní) 
síně Mosteckého MNV v době likvidace budovy.  Tyto fotografie poskytují cenný vhled do 
interiérového designu a architektonických detailů, které byly typické pro tuto dobu. Fotografie, 
které byly použity, jsou ve velmi špatném stavu, což představuje další výzvu při jejich 
restaurování. 

3. Stav fotografií 

Historické interiérové fotografie byly skenovány ve vysokém rozlišení do digitálního formátu 
TIFF. Tyto skeny zahrnují: 

● Černobílé fotografie: Fotografické snímky byly pořízeny v černobílém formátu. 
● Rozlišení: 4986 x 6914 pixelů, bitová hloubka 24b. 
● Fyzické poškození: Viditelné škrábance, trhliny, prach a další poškození způsobená 

časem a nedostatečným skladováním. 
● Problémy s expozicí: Zřejmě špatně nafocené fotografie, kde kontrast mezi vnitřním 

a venkovním osvětlením způsobil problémy s viditelností detailů. Tato fotografie 
vykazuje problémy s přeexponovanými oblastmi, které jsou velmi světlé, a 
podexponovanými oblastmi, které jsou naopak velmi tmavé. 

4. Použitý hardware 

Pro veškeré úpravy fotek s vysokým rozlišením byl použit notebook Lenovo Legion Pro 7, 
který poskytuje dostatečný výpočetní výkon pro zpracování a restaurování historických 
fotografií. Technické specifikace zahrnují: 

● Procesor: Intel Core i9 
● Grafická karta: NVIDIA GeForce RTX 4090 
● RAM: 32GB 
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5. Postup retušování a kolorizace 

Pro retušování a kolorizaci interiérových fotografií byly použity kombinované metody 
zahrnující automatizované nástroje a manuální úpravy. Vybraný postup byl postup A4 a B3 
vzhledem k nutnosti manuální kolorizace i retuše.  

Retušování 

● Automatická detekce a odstranění škrábanců a prachu: Pomocí algoritmů pro 
detekci škrábanců a prachu byly identifikovány a odstraněny nežádoucí prvky (drobné 
bílé skvrnky). Tyto algoritmy využívají konvoluční neurální sítě (CNN) pro efektivní 
rozpoznání a odstranění poškození. 

● Inpainting: Pro vyplnění oblastí po odstraněných poškozeních byl použit algoritmus 
generative content fill, který využívá vzory okolní oblasti k doplnění chybějících částí 
obrazu. 

● Manuální úpravy: V případech, kde automatizované metody nebyly dostatečné, byly 
provedeny ruční úpravy pomocí nástrojů v Adobe Photoshopu. Tento proces zahrnoval 
pečlivou rekonstrukci poškozených oblastí a odstranění viditelných defektů. 

Kolorizace 

● Automatická kolorizace: Použití nástroje Photoshop pro automatickou kolorizaci 
černobílých fotografií. Tento nástroj využívá hluboké neurální sítě k aplikaci 
realistických barev na černobílé snímky. 

● Nastavení parametrů: Před kolorizací byly fotografie ořezány a upraveny pro 
optimální výsledek. Byly nastaveny parametry jako sytost a redukce šumu podle 
doporučených hodnot. 

6. Výsledky 

Výsledky kombinace automatizovaných a manuálních metod ukazují významné zlepšení v 
retuši a kolorizaci interiérových fotografií. Obrázky před a po úpravě demonstrují efektivitu 
těchto technik. Přesto by v takových případech byla ideální kontrola například s pamětníkem.  

Krvácení barev 

Zatímco u trámů algoritmus správně pozná hnědou barvu, u přesvětlených oblastí kolem 
trámů dochází zřejmě k tzv. přejímaná barev, či krvácení barev (color bleeding). Přesvětlená 
hnědá barva se mění na červenou a ovlivňuje bílou barvu okolí. Jelikož se nejedná o 
urbanistické fotky, nebyl nastaven (dle postupu B2) parametr žlutá/modrá na -15 až -25 ale 
na hodnotu 10. Obdobně parametr purpurová/zelená byl nastaven na hodnotu 3. 

Extenzivní poškození 

Fotografie jsou značně mechanicky poškozené. K odstranění poškození byl aplikován postup 
A3 s hodnotou parametru odstranění šumu 80 a to dvakrát za sebou s následnou manuální 
opravou dvou zbylých oblastí a vyplněním generativním obsahem. Jak varuje postup A3, 
hodnota 80 vede k časově náročným opravám, každá iterace filtru zabrala 8-10 minut.  
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Obr. 1: Původní interiérová fotografie s viditelnými poškozeními a problémy s expozicí. 
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Obr. 2: Fotografie po automatické kolorizaci. Díky původnímu přesvětlení jsou barvy 
nastaveny zcela špatně a je zapotřebí manuální korekce pomocí ohniskových bodů. 
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Obr. 3: Nastavení ohniskových bodů definujících (předpokládanou) bílou barvu stěny 
(nahoře), výsledek manuální kolorizace (dole).  
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Obr. 4: Fotografie po finálních automatických a manuálních úpravách dle postupu B3. 
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7. Dílčí závěr 

Nastavení automatické kolorizace a retuše bylo provedeno s navrženými parametry dle 
technologie využívající konvoluční neurální sítě a inpainting. Přestože automatické metody 
poskytly uspokojivé výsledky, v těchto případech byly nutné finální manuální úpravy k 
dosažení maximální kvality a věrnosti obnoveného obrazu. Zároveň vzhledem k vysokému 
mechanickému poškození bylo nutno zvolit maximální doporučené hodnoty, což vedlo z 
extrémnímu skoku časové náročnosti, a to i na použitém hardware. 

Výsledky ukazují, že přestože jsou původní postupy navržené primárně pro exteriérové 
fotografie budou, je možné je použít (při změně některých parametrů, jak je navrženo v 
jednotlivých postupech) i na fotografie interiéru. Technologie a metodologie popsané v této 
zprávě se ukázaly jako efektivní a spolehlivé nástroje pro restaurování interiérových fotografií. 
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Část D: Kolorizace a retuš velkých historických fotografií 

Radek Richtr 

1. Úvod 

Kolorizace a retuš historických fotografií je klíčovou činností pro uchování a prezentaci 
kulturního a historického dědictví. V této zprávě se zaměříme na procesy a technologie 
použité při kolorizaci a retuši velkých historických fotografií z města Most. Tyto fotografie byly 
digitalizovány do formátu TIFF, které poskytují bezztrátovou kompresi a zachovávají vysokou 
kvalitu obrazu. Tento dokument popisuje ověření postupů, technické specifikace a časovou 
dotaci potřebnou pro obnovu těchto fotografií. 

2. Specifikace vstupních dat 

Typ fotografie 

● Typ fotografie: Barevné skeny černobílých fotografií  
● Lokalita: Exteriéry budov v městě Most před jeho zbořením 

Formát a velikost souborů 

● Původní formát: TIFF (Tagged Image File Format) 
○ Velikost: 500 - 750 MB 

Rozlišení a kvalita 

● Rozlišení: cca 11497 x 14279 pixelů (v závislosti na natočení skenovaného materiálu) 
● Bitová hloubka: 24 bitů 

Stav a poškození 

● Fyzické poškození: Viditelné škrábance, trhliny, prach a další poškození způsobená 
časem a nedostatečným skladováním. Časté drobné mechanické poškození 
(prasklinky fotografie). 

● Problémy s expozicí: Některé fotografie vykazují problémy s přeexponovanými 
oblastmi, které jsou světlejší, což je problém pro automatickou kolorizaci.  

3. Použitý hardware 

Pro veškeré úpravy fotek s vysokým rozlišením byl použit notebook Lenovo Legion Pro 7, 
který poskytuje dostatečný výpočetní výkon pro zpracování a restaurování historických 
fotografií. Technické specifikace zahrnují: 

● Procesor: Intel Core i9 
● Grafická karta: NVIDIA GeForce RTX 4090 
● RAM: 32GB 
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4. Postup kolorizace a retuše 

Pro kolorizaci a retuš těchto velkých historických fotografií byly použity primárně postupy 
automatické kolorizace B1 a retuše A1. V případě nedostatečného výsledku pak s manuální 
úpravou kolorizace B2. Nežádoucí objekty byly odstraněny postupem A3.  

Kolorizace 

● Automatická kolorizace: Použití nástroje Photoshop pro automatickou kolorizaci 
černobílých fotografií. Tento nástroj využívá hluboké neurální sítě k aplikaci 
realistických barev na černobílé snímky. 

● Nastavení parametrů: Před kolorizací byly fotografie ořezány a upraveny pro 
optimální výsledek. Byly nastaveny parametry dle postupu B1 a B2. 

● Manuální doladění barev: Po automatické kolorizaci byly fotografie v případě 
přeexponování manuálně doladěny v Adobe Photoshopu postupem B2, aby se 
dosáhlo co nejpřesnějšího a nejrealističtějšího výsledku. 

Retušování 

● Automatická detekce a odstranění škrábanců a prachu: Pomocí algoritmů pro 
detekci škrábanců a prachu byly identifikovány a odstraněny nežádoucí prvky 
postupem A1. Tyto algoritmy využívají konvoluční neurální sítě (CNN) pro efektivní 
rozpoznání a odstranění poškození. 

● Inpainting: Pro vyplnění oblastí po odstraněných poškozeních byl použit algoritmus 
generative content fill dle postupu A3, který využívá vzory okolní oblasti k doplnění 
chybějících částí obrazu. 

5. Časová dotace 

Časová dotace pro úpravu těchto velkých fotografií se liší podle míry poškození a potřeby 
manuálních úprav. Naskenované fotografie jsou poměrně veliké jak rozlišením, tak paměťově. 
Je vhodné zmínit, že už prostá manipulace s nimi (načtení, uložení, atd) muže trvat i několik 
minut.  

● Optimální případ (pouze automatické úpravy): cca 10 minut na fotografii. 
● Středně poškozené fotografie (potřeba manuálních úprav): 25-30 minut na 

fotografii. 
● Silně poškozené fotografie (mnoho drobných poškození): Až 3 hodiny na 

fotografii. 

Zhruba 50% - 60% naskenovaných fotek lze opravit jednoduchými automatickými postupy. 
nejčastější chybou je problematické expozice, která vyžaduje manuální zásahy do kolorizace 
(postup B2), které jsou sice jednoduché, ale vzhledem k velikosti fotek časové nákladné. jen 
jednotky fotek jsou tak poškozeny, že jak automatické kolorizace, tak odstranění šumu a vad 
zabere více než tři hodiny času. obvykle se jedná o velmi velké množství velmi malých chyb, 
které není vhodné odstranit postupem A3 (generativní obsah), ale naopak vyžaduje vysokou 
časovou dotaci automatického postupu A1.  
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6. Výsledky 

Výsledky kombinace automatizovaných a manuálních metod ukazují významné zlepšení v 
kolorizaci a retuši historických fotografií. Obrázky před a po úpravě demonstrují efektivitu 
těchto technik. 

 

 

Obr. 1: Ukázky obarvených a retušovaných fotografií; vlevo originál, vpravo upravená 
fotografie.   
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Obr. 2: Ukázky obarvených a retušovaných fotografií; vlevo originál, vpravo upravená 
fotografie.   
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Obr. 3: Ukázky obarvených a retušovaných fotografií; vlevo originál, vpravo upravená 
fotografie.   
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Obr. 4: Ukázky obarvených a retušovaných fotografií; vlevo originál, vpravo upravená 
fotografie.   
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Obr. 5: Ukázky obarvených a retušovaných fotografií; vlevo originál, vpravo upravená 
fotografie.   
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Obr. 6: Ukázky obarvených a retušovaných fotografií; vlevo originál, vpravo upravená 
fotografie.   
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Obr. 7: Ukázky obarvených a retušovaných fotografií; vlevo originál, vpravo upravená 
fotografie.   
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Obr. 8: Ukázky obarvených a retušovaných fotografií; vlevo originál, vpravo upravená 
fotografie.   



137 

 

 

 

Obr. 9: Ukázky obarvených a retušovaných fotografií; vlevo originál, vpravo upravená 
fotografie.   
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Obr. 10: Ukázky obarvených a retušovaných fotografií; vlevo originál, vpravo upravená 
fotografie.   
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Obr. 11: Nahoře: detail poškozené fotografie. Vlevo dole: ukázky již obarvené fotografie 
(snímek z procesu odstranění z Photoshopu), která obsahuje vysoké množství drobných 
chyb (škrábance, prasklinky). Odhadovaný čas tří hodin narostl až na 342 minut. Vpravo 

dole: Detail výstupu.   
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Obr. 12: Ukázka dalšího typu vady k retuši.  
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Obr. 13: Velmi poškozená fotografie s množstvím velmi drobných chyb 
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Obr. 14: Velmi poškozená fotografie, kolorováno, retušováno. Čas automatické retuše 133 
minut.    
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7. Dílčí závěr 

Nastavení automatické kolorizace a retuše bylo provedeno s navrženými parametry dle 
technologie využívající konvoluční neurální sítě a inpainting. Přestože automatické metody 
poskytly uspokojivé výsledky, v některých případech byly nutné finální manuální úpravy k 
dosažení maximální kvality a věrnosti obnoveného obrazu. Použití těchto postupu jí sice 
jednoduchá, ale časově náročné vzhledem k velikostem a detailu fotek však očekávané.  

Výsledky ukazují, že kombinace automatických a manuálních technik poskytuje vysoce 
kvalitní obnovu historických fotografií, která je důležitá pro jejich další využití v historických 
studiích a digitálních archivech. Technologie a metodologie popsané v této zprávě se ukázaly 
jako efektivní a spolehlivé nástroje pro kolorizaci a retuš velkých historických fotografií, a to i 
s použitím přibližných referenčních hodnot z původních, kolorovaných fotografií, či barevných 
kreseb.  

Závěr 

Na základě provedených testů a analýz můžeme potvrdit, že bylo ověřeno, že technologie 
digitálního restaurování starých fotografií budov pro tvorbu virtuálních 3D modelů městské 
zástavby splňuje požadavky na provádění kolorizace a retuše historických fotografií, zejména 
těch s velkým rozlišením a významným stupněm poškození. Testování ukázalo, že tato 
technologie je schopna efektivně zpracovávat fotografie, obnovovat detaily, eliminovat 
škrábance, prach a další nedokonalosti, a zároveň poskytuje vysoce kvalitní výsledky jak v 
automatických, tak manuálních režimech. 

Technologie se ukázala jako spolehlivá nejen v případech, kde byly požadovány základní 
automatické úpravy, ale i v situacích, kdy byly nezbytné pokročilé manuální zásahy. Ačkoli 
některé úkony, zejména u velkých a detailních fotografií, vyžadují nemalou časovou dotaci, 
celkové výsledky potvrzují, že kombinace automatizovaných a manuálních postupů zajišťuje 
maximální věrnost a kvalitu obnoveného obrazu. 

Tímto potvrzujeme, že technologie digitálního restaurování starých fotografií budov pro tvorbu 
virtuálních 3D modelů městské zástavby je plně vhodná pro použití v historických studiích a 
digitálních archivech, a že poskytuje nástroje nezbytné pro zachování a prezentaci kulturního 
dědictví s důrazem na přesnost a autentický vzhled výsledných fotografií. 
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